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 1 Uvod u uredski paket OpenOffice.org

 1.1 Ciljevi ovog poglavlja

Nakon ovog poglavlja moći ćete:
• definirati osnovne karakteristike uredskog paketa 

OpenOffice.org i slobodnog softvera,
• ukratko prikazati povijest paketa OpenOffice.org,
• navesti dijelove paketa OpenOffice.org,
• instalirati i pokrenuti OpenOffice.org.

 1.2 Uvod u OpenOffice.org

 1.2.1 Projekt OpenOffice.org

OpenOffice.org  je  projekt  temeljen  na  filozofiji  slobodne 
programske  podrške  (Free 
Software).  U  ovom  trenutku 
njegov razvoj podržava i velikim 
dijelom  omogućava  tvrtka  Sun 
Microsystems. Kao i kod mnogih drugih programa otvorenog 
koda, točan broj programera koji sudjeluju na njegovoj izradi 
nije moguće odrediti, budući da su svi pozvani sudjelovati na 
njegovom  unaprjeđenju  i  poboljšanju.  Prema  zadnjim 
podacima, broj sudionika projekta procjenjuje se na više od 
180.000 osoba iz cijelog svijeta.

Za  instalaciju  i  korištenje  paketa  OpenOffice.org  nije 
potrebno plaćati licenciju, već se on može koristiti bez ikakve 
naknade  za  sve  namjene,  kako  u  komercijalne  tako  i  u 
obrazovne namjene.

OpenOffice.org  je  raspoloživ  na velikom broju platformi.  To 
korisnicima  omogućava  znatno  jednostavniju  promjenu 
platformi  ako  se  za  to  odluče.  U  ovom  trenutku 
OpenOffice.org  se može preuzeti  u  izvršnom obliku za ove 
platforme:

• Microsoft Windows,
• GNU / Linux,
• Solaris,
• FreeBSD,
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ispitivanja,  zapošljavanja  ili  potpisivanja  ugovora  o  tajnosti 
podataka kako biste mogli raditi na unaprjeđenju postojećeg 
programa.  Za  sudjelovanje  je  dovoljno  samo imati  znanja, 
vremena i dobre volje.

Prednosti  ovakvih  projekata  su  otvorenost  prema  svim 
sudionicima i otvoreni poziv drugima na aktivno sudjelovanje. 
Sama  filozofija  slobodnog  softvera  temelji  se  na  četiri 
osnovne slobode:

1. sloboda uporabe programa za sve namjene;
2. sloboda uvida u rad programa i prilagodbe potrebama – 

za ovo je potrebno imati pristup izvornom kodu 
programa;

3. sloboda širenja kopija programa;
4. sloboda poboljšanja programa i dijeljenje te poboljšane 

inačice drugima.

 1.2.3 Povijest uredskog alata OpenOffice.org

Povijest  uredskog  alata  OpenOffice.org  započinje  1994. 
godine  kada njemačka tvrtka  StarDivision,  osnovana 1986. 
godine, započinje razvoj svojeg alata “StarOffice suite”. 1999. 
godine tvrtku StarDivision i sva prava nad njenom razvijenom 
programskom  podrškom  kupuje  tvrtka  Sun  Microsystems 
kako  bi  imala  proizvod  koji  može  konkurirati  istovrsnim 
komercijalnim uredskim alatima.

Nedugo nakon preuzimanja 2000. godine,  Sun Microsystems 
nudi svim privatnim korisnicima potpuno besplatno, uredski 
alat  StarOffice  5.2.  Iste  godine  pokreće  se  i  projekt 
OpenOffice.org.  U  ovom  trenutku  aktualna  je  inačica 
OpenOffice.org 2 koja je prevedena i na hrvatski jezik.

 1.2.4 Dijelovi uredskog paketa OpenOffice.org

OpenOffice.org  se sastoji od nekoliko osnovnih programskih 
alata:

• Writer – Obrada teksta,
• Calc – Tablične kalkulacije,
• Impress – Prezentacije,
• Draw – Vektorska grafika,
• Base – Baza podataka,
• Math – Prikaz matematičkih formula i jednadžbi.
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Writer – obrada teksta

Writer je program za obradu teksta, izradu pisama, izvještaja, 
brošura  i  drugih  dokumenata.  U  svaki  od  dokumenata 
moguće  je  umetnuti  grafiku  i  objekte.  Writer  može čitati  i 
snimati podatke u nekoliko zapisa kao što su:

• ODT – vlastiti zapis temeljen na otvorenoj normi ISO/IEC 
26300 za elektroničke uredske dokumente,

• DOC – inačica zapisa Microsoft Word dokumenata,
• HTML – Hypertext Markup Language – zapis dokumenata 

weba,
• XHTML – Extended Hypertext Markup Language – 

prošireni zapis dokumenata weba,
• XML – Extended Markup Language – prošireni zapis 

dokumenata weba,
• PDF – Portable Document Format – samo kreiranje, ne i 

otvaranje .pdf dokumenata,
• i mnogi drugi.

Prema svojim karakteristikama  Writer  se može usporediti  s 
programskim alatima:

• Microsoft Word,
• WordPerfect.

Calc – tablične kalkulacije

Calc omogućava  sve  napredne  mogućnosti  programa  za 
izradu  tabličnih  kalkulacija  kao  što  su:  proračuni,  analiza 
podataka,  izrada  grafova  te  mogućnosti  donošenja  odluka. 
Uključuje  preko  300  različitih  funkcija  za  financijske, 
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statističke  i  matematičke  operacije.  Na  temelju  unesenih 
podataka  moguće  je  izraditi  velik  broj  različitih  2D  i  3D 
grafikona  koji  se  mogu  jednostavno  uključiti  u  druge 
dokumente.  Podaci  se  mogu  zapisati  u  obliku  sukladnom 
istovrsnim komercijalnim alatima.

Prema  svojim  karakteristikama  Calc  se  može  usporediti  s 
programskim alatima:

• Microsoft Excel,
• Word Perfect - Quattro Pro.

Impress – prezentacije

Impress  ima sve karakteristike naprednih programskih alata 
za izradu prezentacija kao što su rad sa specijalnim efektima, 
prijelazima  između  slajdova  i  animacijama.  Integriran  je  s 
naprednim grafičkim mogućnostima koje pružaju programski 
alati Draw i Math.

Prezentacije se mogu dodatno istaknuti uporabom specijalnih 
efekata  teksta,  zvuka  i  video  zapisa.  Svi  podaci,  osim  u 
vlastitom  formatu  ODP,  mogu  se  zapisivati  u  obliku 
sukladnom  srodnom  komercijalnom  alatu,  a  ugrađena  je  i 
mogućnost  izravnog  pohranjivanja  u  obliku  Macromedia 
Flash (SWF).

Prema svojim karakteristikama Impress se može usporediti s 
programskim alatima:

• Microsoft PowerPoint,
• WordPerfect – Presentations.
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Draw – vektorska grafika

Draw  omogućava  izradu  vektorske  grafike  kojom se  mogu 
grafički  prikazati  jednostavni  crteži,  grafikoni,  sve  do  3D 
grafika.  Korištenjem  mogućnosti  “Smart  Connectors” 
jednostavno  je  povezivanje  elemenata  koji  čine  grafiku 
uporabom strelica.

Grafika izrađena u programskom alatu Draw može se koristiti 
u  svim  drugim  programskim  alatima  u  uredskom  paketu 
OpenOffice.org.  Draw  može  snimiti  podatke  u  više  od  20 
različitih zapisa, a neki od popularnijih su:

• PNG,
• HTML,
• PDF,
• Flash.
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Base – baze podataka

Base  omogućava  pristup  i  rad  s  bazama  podataka 
korištenjem  jednostavnog  grafičkog  sučelja.  Upotrebom 
čarobnjaka moguće je brzo kreirati obrasce, izvještaje, upite, 
tablice, poglede i odnose.

Kao osnovni oblik baze, Base koristi relacijsku bazu podataka 
HSQLDB. Osim ove baze bez instalacije dodatnih alata može 
koristiti i dBASE, Microsoft Access, MySQL i Oracle, ali i sve 
druge baze koji su dostupne putem sučelja ODBC i JDBC.

Prema  svojim  karakteristikama  Base  se  može  usporediti  s 
programskim alatima:

• Microsoft Access,
• WordPerfect – Paradox.
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Math – Uređivanje matematičkih formula i jednadžbi

Math je namijenjen izradi i uređivanju matematičkih formula i 
jednadžbi.  Za  izradu  složenih  formula  moguće  je  koristiti 
grafičko sučelje koje uključuje simbole i  znakove koji  inače 
nisu  dostupni  u  uobičajenom fontu.  Math  se  može koristiti 
kao  samostalni  programski  alat,  ali  i  kao  dio  drugih 
programskih  alata  OpenOffice.org.  Kao  samostalni  alat 
podatke može snimati u normi MathML namijenjenoj zapisu 
matematičkih formula na Webu.

Uz  grafičko  sučelje,  formule  je  moguće  unositi  i  u 
tekstualnom obliku,  što  u  nekim slučajevima može  znatno 
ubrzati unos i uređivanje složenih formula bez uporabe miša.

 1.2.5 Proširivanje uredskog paketa OpenOffice.org

OpenOffice.org  nudi  mogućnost  proširenja  u  obliku  pisanja 
makro  naredbi  i  u  obliku  izrade  dodatnih  programa 
(plug-inova) koji proširuju postojeće mogućnosti.

Za izradu makro naredbi  OpenOffice.org  koristi  programski 
jezik  OpenBasic.  Osim njega, makro naredbe za moguće je 
izraditi u sljedećim programskim jezicima:

• Beanshell – programski jezik nalik na programski jezik 
Javu,

• Java – napredni programski jezik prema nekim 
karakteristikama i sintaksi sličan programskim jezicima 
C++ i kasnije nastalom C#,

• JavaScript – jednostavan skriptni jezik prema sintaksi 
nalik na programske jezike Java i C++ ,
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• Python – napredni programski jezik.
Za izradu dodatnih programa OpenOffice.org nudi mogućnost 
njihove izrade u programskim jezicima C, C++, Java i Python.

 1.3 Početak rada s uredskim paketom 
OpenOffice.org

 1.3.1 Instalacija uredskog paketa OpenOffice.org

Za  instalaciju  paketa  OpenOffice.org  potrebno  je  prvo 
preuzeti instalacijske datoteke. Najjednostavnije ih je preuzeti 
izravno  sa  službene  web  stranice  projekta 
http://www.openoffice.org,  a  moguće  ih  je  preuzeti  i 
upotrebom brojnih Peer2Peer protokola kao što je BitTorrent.

Osim izravnim preuzimanjem s Interneta moguće je kupiti i 
CD-ROM  distribuciju  od  nekog  od  distributera  paketa 
OpenOffice.org.

Hrvatsku  inačicu  najjednostavnije  je  preuzeti  izravno  sa 
stranica  projekta  lokalizacije:  http://lokalizacija.linux.hr  koja 
je rezultat rada Hrvatske udruge Linux korisnika – HULK.

Nakon preuzimanja datoteke, potrebno je instalirati program 
dvostrukim  klikom  na  datoteku  Setup.exe,  nakon  čega  se 
pokreće  instalacija.  Ovisno  o  preuzetoj  inačici,  instalacija 
može biti na hrvatskom, engleskom ili nekom drugom jeziku.
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 1.3.2 Koraci instalacije

Slika 7: Korak 
1

Prvi dijaloški  
okvir 
obavještava da 
će se 
OpenOffice.org 
prvo otpakirati i  
zatim se 
automatski 
pokrenuti  
postupak 
instalacije.
Za nastavak 
instalacije kliknite na gumb Sljedeće (Next).

Slika 8: Korak 
2

U ovom koraku 
instalacije 
odaberite 
mapu u koju 
želite otpakirati  
datoteke 
potrebne za 
instalaciju 
paketa 
OpenOffice.org.  
Za odabir nove 
mape kliknite na 
gumb Pregledaj (Browse) i odaberite novu mapu. To nije 
mapa u koju će se OpenOffice.org instalirati već privremeno 
mjesto odpakiravanja instalacijskih datoteka. Kliknite na 
gumb Otpakiraj (Unpack) za nastavak instalacije.
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Slika 9: Korak 
3

Pričekajte dok se 
sve datoteke 
uspješno ne 
otpakiraju u 
instalacijsku 
mapu koju ste 
odabrali u 
prethodnom 
koraku i 
automatski 
pokrene idući 
korak.

Slika 10: Korak 
4

Za početak 
instalacije 
kliknite na gumb 
Sljedeće (Next).
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Slika 11: Korak 
5 

U ovom koraku 
ispisuje se 
licencija - uvjeti  
korištenja 
programa. 
Za nastavak 
instalacije 
pročitajte 
licenciju,  
odaberite 
Prihvaćam 
uvjete u 
licencnom ugovoru (I accept the terms in the licence 
agreement) te potvrdite nastavak instalacije klikom na gumb 

Sljedeće (Next). 

Slika 12: Korak 
6 

Prije prelaska na 
sljedeći korak 
ispunite podatke 
o korisniku 
paketa 
OpenOffice.org. 
Kada ste sve 
ispunili, kliknite 
na gumb 
Sljedeće (Next) 
za nastavak 
instalacije.
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Slika 13: Korak 
7

Odaberite način 
instalacije: 
Završi 
(Complete) za 
potpunu 
instalaciju ili 
Prilagođeno 
(Custom) za 
prilagođenu 
instalaciju. 
Ako niste 
sigurni,  
odaberite Završi (Complete), te kliknite na gumb Sljedeće 
(Next) za nastavak instalacije.

Slika 14: Korak 
8

Ako na računalu 
nemate 
instaliran 
Microsoft Office,  
svakako 
označite sve 
mogućnosti kako 
biste te 
dokumente 
mogli izravno 
uređivati u 
programskom 
alatu OpenOffice.org. Za nastavak instalacije kliknite na 
gumb Sljedeće (Next). 
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Slika 15: Korak 
9

Sada ste završili  
sa svim 
pripremama 
potrebnim za 
samu instalaciju. 
Za početak 
instalacije 
kliknite na gumb 
Instaliraj 
(Install). 

Slika 16: Korak 
10

U ovom koraku 
trebate pričekati 
da 
OpenOffice.org 
instalira sve 
potrebne 
datoteke na 
vaše računalo. 
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Slika 17: Korak 
11

Ako je sve 
uspješno 
instalirano, 
pojavit će se 
poruka o 
uspješnosti 
instalacije. 
Odabirom 
Završi (Finish) 
završit ćete 
instalaciju. 
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 1.3.3 Pokretanje programskog paketa OpenOffice.org

Ako  je  na  računalu  instaliran  operativni  sustav  Microsoft 
Windows XP, Calc možete pokrenuti na sljedeći način:

1. kliknite na Start (Start) u donjem lijevom dijelu,

2. kliknite na link Svi programi (All programs),

3. odaberite link OpenOffice.org ,

4. odaberite  odgovarajući  programski  alat  (na  primjer: 
Writer za pisanje teksta).

Slika 18: 

Pokretanje 
programskih 
alata 
OpenOffice.org

 

 1.4 Česta pitanja

Je li ovaj program demo inačica?

Ne,  ovo  nije  demo  inačica,  već  je  to  potpuni  programski 
paket.  OpenOffice.org sadrži  sve dijelove i  ni  na koji  način 
nije  ograničena  njegova  uporaba  u  skladu  s  licencijom 
otvorenog koda.

Mogu li  slobodno  kopirati  i  distribuirati  kopije  ovog 
programskog paketa? Na primjer, snimiti ih kolegama 
ili dati prijateljima?

Da,  u  skladu  s  licencijom  slobodne  programske  potpore 
možete  slobodno  kopirati  i  distribuirati  kopije  ovog  paketa 
bez  naknade.  Za  kopiranje  i  distribuiranje  možete  tražiti 
naknadu koja ničime nije ograničena.

Na  koliko  računala  smijem  instalirati  jednu  kopiju 
programskog paketa?

Jednu  kopiju  programskog  paketa  možete  instalirati  na 
neograničeni broj računala.

Mogu  li  koristiti  programski  paket  u  komercijalne 
svrhe?
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Programski  paket  možete  koristiti  bez  ikakve  naknade  u 
komercijalne, obrazovne, osobne te bilo koje druge namjene.

Zašto  je  ovaj  programski  alat  besplatan,  a  drugi  se 
plaćaju?

Izradu ovog programskog alata podržava i sponzorira tvrtka 
Sun Microsystems  a na njoj  rade stručnjaci – dobrovoljci  iz 
cijeloga svijeta koji ne traže naknadu za svoj rad.

Tko je vlasnik autorskih prava programskog paketa?

Vlasnik  autorskih  prava  je  tvrtka  Sun  Microsystems  i  svi 
dobrovoljci koji sudjeluju na projektu.

Može li  se licencija  promijeniti?  Hoću li  biti  prisiljen 
platiti programski paket za nekoliko godina?

Licencija koja se koristi (GPL) napisana je tako da se ne može 
promijeniti  i  povući,  dakle  autori  ne  mogu  „uzeti  softver 
natrag”.

Zašto trebam Javu za pokretanje? Je li  ovaj program 
pisan u Javi?

Java je potrebna za pokretanje nekih dijelova programa od 
kojih  je  najznačajnija  relacijska  baza  podataka  HSQLDB. 
OpenOffice.org pisan je u programskom jeziku C++, a Java se 
koristi samo za proširivanje nekih mogućnosti. Bez upotrebe 
Jave moguće je koristiti velik dio mogućnosti programa.

Mogu li koristiti dijelove programa (ili cijeli program) u 
sklopu svojeg programa?

Možete, ali samo u skladu s pravilima licencije GPL.

Je li OpenOffice.org bolji od nekih drugih komercijalnih 
alata iste namjene?

Za  izradu  raznih  vrsta  dokumenata,  pisama,  brošura, 
dokumentacije,  znanstvenih  radova  OpenOffice.org  pruža 
mogućnosti usporedive s vodećim komercijalnim alatima za 
istu namjenu.

U  ovom  trenutku  neki  komercijalni  alati  pružaju  veće 
mogućnosti korisniku nego što to čini OpenOffice.org u obliku 
različitih  programskih  alata  i  pomagala  za  bržu  izradu 
pojedinih  dijelova  dokumenta,  kao  i  napredne  analize  i 
obrade dokumenata.
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OpenOffice.org  nudi  mogućnost  proširivanja,  izmjene  i 
potpunog prilagođavanja nego što je to slučaj s komercijalnim 
alatom. 

Komercijalne  alate  nije  dozvoljeno  koristiti  bez  plaćene 
licencije,  kao  niti  dijeliti  drugima  i  instalirati  na  druga 
računala za koja nije plaćena odgovarajuća licencija. Uporaba 
komercijalnih programa bez odgovarajuće licence je kažnjivo 
djelo. 

S druge strane programski paket  OpenOffice.org  moguće je 
mijenjati,  dograđivati,  distribuirati,  koristiti  i  instalirati  bez 
plaćanja dodatnih licenci i naknada.

 1.5  Zadaci za vježbu

 1. Preuzmite  instalacijske  datoteke  uredskog  paketa 
OpenOffice.org  sa  stranica  www.openoffice.org. 
Instalirajte OpenOffice.org. 

 a) U koliko koraka se provodi instalacija?

 b) Koje ovlasti trebate imati za instalaciju?
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 2 Korištenje programskog alata Writer

Programski  alat  Writer  dio  je  uredskog  paketa 
OpenOffice.org  i  služi  izradi  oblikovanih  dokumenata  koji 
sadrže tekst, slike i druge objekte, poput pisama, poslovnih 
dopisa,  izvješća  i  slično.  Dokumenti  se  uređuju  po  načelu 
"Dobiješ što vidiš" (eng."What You See is What You Get"), što 
znači da je izgled dokumenta na zaslonu za vrijeme izrade 
jednak izgledu ispisanog dokumenta. 

Aplikacija ima mnoštvo naprednih mogućnosti, poput rada sa 
slikama,  jednostavnijim  tablicama,  automatske  izrade 
sadržaja, izrade cirkularnih pisama i sličnog.

 2.1 Ciljevi ovog poglavlja

Nakon ovog poglavlja moći ćete:
• otvoriti programski alat Writer,
• izraditi novi dokument,
• spremiti i otvoriti prethodno spremljeni dokument,
• upravljati korisničkim sučeljem programskog alata,
• promijeniti osnovne postavke programskog alata.

 2.2 Prvi koraci u radu s programskim alatom

 2.2.1 Otvaranje programskog alata

Otvaranje programskog alata Impress vrši se putem izbornika 
Start, obično putem: 

Start → All Programs → OpenOffice.org 2.2 →

 OpenOffice.org Writer

Moguće  je  da  na  radnoj  površini  postoji  i  kratica  za  brže 
otvaranje programskog alata.

Aplikaciju možete jednostavno zatvoriti na jedan od sljedećih 
načina:

• odabirom  znaka u  gornjem  desnom  uglu 
programskog alata,

• putem trake izbornika, Datoteka (File) → Izlaz (Exit).
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Prilikom izlaska, ako je dokument promijenjen nakon zadnjeg 
spremanja, pojavit će se izbornik za spremanje dokumenta.

 2.2.2 Radno okruženje

Na  slici  je  prikazano  radno  okruženje,  slično  mnogim 
programskim alatima, dijelovima uredskih paketa.
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Slika 20: Izgled radnog okruženja u programskom alatu 
Writer

Slika 19: 
Dijaloški okvir za 
spremanje dokumenta



Glavni dijelovi sučelja su:

• Naslovna traka (Title Bar)

U  lijevom  dijelu  naslovne  trake  možete  pročitati  naziv 
dokumenta kojeg ste otvorili  (openoffice) i  u kojem se od 
programskih  alata  OpenOffice.org  trenutno  nalazite 
(OpenOffice.org Writer).

U desnom dijelu naslovne trake nalaze se standardne ikone 
za rad s programskim alatom (smanjivanje,  povećavanje ili 
zatvaranje programkosg alata).

• traka izbornika (Menu Bar)

Odmah ispod naslovne trake nalazi se glavna traka izbornika. 
Uz  pomoć  ove  trake  moguće  je  napraviti  sva  oblikovanja 
dokumenta i podataka. 

• alatne trake (Toolbars)

Alatne  trake  su  najčešće  smještene  ispod  iznad  samog 
područja  za  unos  sadržaja,  odnosno  ispod  trake  izbornika. 
Moguće je da se te trake nalaze i na drugim mjestima oko 
samog polja za unos ili da su otvorene unutar novog prozora. 

• vodoravno i okomito ravnalo (Rulers)

Ravnala su smještena iznad i lijevo od prostora za uređivanje 
teksta.  One pomažu u snalaženju po dokumentu,  pokazuju 
apsolutne veličine prostora  za pisanje i  margina,  te mjesta 
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Slika 21: Naslovna traka

Slika 23: Uobičajene alatne trake
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granica za tabulatore.

• prostor za uređivanje teksta

Prostor za uređivanje teksta zauzima središnji, najveći prostor 
programskog alata. 

• statusna traka (Status Bar)

Na samom dnu dokumenta nalazi se statusna traka. Na njoj 
možete vidjeti broj stranica i trenutnu stranicu, stil trenutne 
stranice,  postotak  veličine  prikaza  stranice  te  nekoliko 
dodatnih svojstava.

Sučelje  možete  jednostavno  prilagoditi  iz  trake  izbornika 
Uređivanje (Edit), gdje možete odabrati elemente koje želite 
imati na radnoj površini. 

OpenOffice.org Navigator

Navigator  je  alat  koji  omogućuje  brzo  snalaženje  u 
programskim  alatima  paketa  OpenOffice.org.  Posebno  je 
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koristan  na  velikim  dokumentima  u  programskom  alatu 
Writer. Navigator možete otvoriti na sljedeće načine:

• putem trake izbornika, Uređivanje (Edit) → Navigator 
(Navigator),

• putem alatne trake, klikom na ikonu Navigator,

• tipkom F5. 

Navigotar  pomaže u snalaženju  unutar  dokumenta,  dijeleći 
dokument na jasne i korisne cjeline. Po cjelinama Navigatora 
kreće  se  korištenjem  znakova  plus  i  minus  (poput  rada  s 
datotekama u operacijskom sustavu). Grupa  Naslov  u sebi 
sadrži  sve  razine  poglavlja/naslova  u  dokumentu.  Ostale 
grupe sadrže elemente poput tablica, grafika, unesenih OLE 
objekata,  hiperveza  i  slično.  Dvostruki  klik  lijevom  tipkom 
miša na bilo  koji  objekt  označava objekt  i  prikazuje  ga na 
zaslonu.

Kontekstni izbornik

Pri radu s programskim alatom Writer, kao i s mnogim drugim 
programskim  alatima,  često  ćete  se  susretati  s  pojmom 
kontekstnog  izbornika.  To  je  izbornik  kojeg  možete  dobiti 
klikom desnom tipkom miša na neki  objekt  (tekst,  ćeliju  u 
tablici, sliku, itd.). Sam naziv izbornika govori kako je ovisan o 
kontekstu,  tj.  o  objektu  koji  je  odabran.  Tako  se  naredbe 
unutar  izbornika  mijenjaju  ovisno  o  mogućnostima 
navedenog objekta. Kontekstni je izbornik dobar način za brz 
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rad s programskim alatom, jer se vrlo često mogućnost koju 
želite primijeniti na objekt nalazi na dohvat samo jednog klika 
mišem.

 2.2.3 Otvaranje dokumenata

Već  postojeći  dokument,  koji  se  nalazi  na  tvrdom  disku 
računala,  mrežnom  disku  ili  nekom  prijenosnom  mediju, 
možete otvoriti na sljedeći način:

• putem trake izbornika, Datoteka (File) → Otvori (Open),

• putem alatne trake, klikom na ikonu Otvori (Open).

Otvara se standardni dijaloški prozor za otvaranje/spremanje 
dokumenata,  gdje  je  potrebno  pronaći  mapu  u  kojoj  se 
dokument nalazi, odabrati željeni dokument i potvrditi odabir.
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 2.2.4 Stvaranje novog dokumenta

Novi  dokument  koji  stvarate  može  biti  potpuno  prazan  ili 
stvoren  prema  nekom  od  predložaka.  Dokument  možete 
izraditi: 

• putem trake izbornika,  Datoteka  (File) →  Novi  (New) → 
Tekstualni dokument (Text Document),

• putem alatne trake, klikom na ikonu Novi (New),

• kombinacijom tipaka Ctrl + N.

Predlošci služe za jednostavniji rad s dokumentima koje često 
koristite.  Na  primjer,  to  mogu  biti  različiti  obrasci  koje 
popunjavate,  dopisi  ili  potvrde.  Zajedničko  je  svim  takvim 
dokumentima da je jedan dio dokumenata uvijek identičan, 
dok  se  drugi  dijelovi  mijenjaju  pri  svakom novom pisanju. 
Kako  biste  skratili  vrijeme  izrade,  dokument  s 
"nepromjenjivim" dijelovima možete spremiti kao predložak 
(template) i kasnije na njemu nastaviti raditi s "promjenjivim" 
dijelovima. 

Dokument  prema  predlošku  možete  kreirati  sljedećim 
koracima:

1. Otvorite  dijaloški  prozor  za  predloške,  na  jedan  od 
sljedećih načina:

• putem  trake  izbornika,  Datoteka  (File)  →  Novi 
(New)  →  Predlošci i dokumenti (Templates  and 
Documente),
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• putem alatne trake, klikom na trokutić pored ikone 

Novi  (New)  →  Predlošci  i  dokumenti 
(Templates and Documente);

2. U  dijaloškom  prozoru  s  lijeve  strane  odaberite 
Predlošci (Templates);

3. Iz popisa mapa odaberite Predlošci (Templates);

4. Odaberite željeni predložak i potvrdite odabir.

Trenutna  hrvatska  inačica  programskog  paketa 
OpenOffice.org  ne sadrži  unaprijed  definirane  predloške za 
Writer. No, korisnici mogu sami napraviti svoje predloške ili ih 
preuzeti s weba.

 2.2.5 Spremanje dokumenta 

Dokumente  je  potrebno  spremiti  kako  biste  sačuvali 
promjene  i  rad  na  dokumentu,  od  početka  ili  od  zadnjeg 
otvaranja.

Dokument možete spremiti:

• putem trake izbornika, Datoteka (File) → Spremi (Save),

• putem alatne trake, klikom na ikonu Spremi (Save).
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Jeste li znali...

Želite li napraviti vlastiti predložak, spremite dokument 
u formatu Predložak OpenDocument teksta (.ott).

Slika 30: 
Izrada novog 
dokumenta prema 
predlošku



 

Ako je datoteka već bila spremljena na neku lokaciju i ima 
svoj naziv, nova inačica biti će spremljena umjesto stare, na 
isto mjesto i pod istim nazivom.

Ako datoteka dosad nije bila spremana, otvara se uobičajeni 
dijaloški  prozor  za  spremanje/otvaranje  dokumenata. 
Korištenjem  padajućeg  izbornika  Spremi  u (Save  in) 
odaberite odredišnu mapu u koju želite spremiti dokument te 
navedite naziv dokumenta (File name).

Spremanje  dokumenta  pod  drugim  nazivom  ili  na 
drugu lokaciju

Ponekad je dokument koji je već spremljen potrebno spremiti 
pod drugim imenom ili na drugu lokaciju. Razlozi za to mogu 
biti  različiti,  poput  potrebe  za  čuvanjem  stare  inačice 
dokumenta ili pohrane na neki prijenosni medij.

Dokument pod drugim imenom ili  na drugo mjesto možete 
spremiti  putem trake izbornika,  Datoteka  (File)  →  Spremi 
kao (Save As).
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Jeste li znali...

Iskusni korisnici vrlo često spremaju dokumente i 
prezentacije. Kako bi uštedjeli vrijeme, jednostavan 
način spremanja je kombinacija tipaka Ctrl + S.



Otvara se isti  dijaloški  prozor kao i  u slučaju da dokument 
nikad nije bio spremljen, s već upisanim trenutnim nazivom 
datoteke i lokacijom, koje je moguće promijeniti.

 2.2.6 Spremanje dokumenta u drugom podatkovnom 
formatu

Uobičajeni format dokumenta u programskom alatu Writer je 
.odt (OpenDocument tekst).  OpenDocument Format  ili 
punim imenom OASIS Open Document Format for Office 
Applications  datotečni  je  format  za  elektroničke  uredske 
dokumente,  koji  je  otvorena  međunarodna  norma  ISO/IEC 
26300:2006. Spremanjem u takav format najlakše je nastaviti 
rad na dokumentu u ovom programskom alatu. No, ponekad 
može  biti  potrebno  spremiti  dokument  u  nekom  drugom 
formatu,  kako  bi  se  mogla  otvarati  pomoću  drugih 
programskih alata. 

Format datoteke možete promijeniti u dijaloškom prozoru za 
spremanje  dokumenta  (vidjeti  prethodna  potpoglavlja),  iz 
padajućeg izbornika Spremi kao tip (Save as type):

Evo nekih najvažnijih formata za spremanje:

• predložak  OpenDocument  dokumenta  (.ott)  – 
predložak  koji  se  kasnije  može  koristiti  za  izradu  novih 
prezentacija,

• Microsoft  Word 97/2000/XP (.doc) – vlasnički  format 
koji se može otvoriti u sličnom programskom alatu, dijelu 
paketa Microsoft Office,

• Rich  Text  Format  (.rtf)  –  standardni  format  za 
oblikovani tekst koji mogu uređivati gotovo svi programski 
alati za oblikovanje teksta,

• Tekst (.txt) – neoblikovani tekst,

• HTML dokument (.html) – format za prikaz web stranica 
na Internetu.
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Dokument  se  pretvara  u  format  PDF  (Portable  Document 
Format) putem trake izbornika,  Datoteka  (File) →  Izvezi u 
PDF (Export as PDF).

 2.2.7 Prijelaz između otvorenih dokumenata

Često je korisno imati više otvorenih dokumenata odjednom, 
za usporedbu inačica, preuzimanje teksta iz druge datoteke i 
slično. Za prijelaz između trenutno otvorenih dokumenata (i 
svih  ostalih  trenutno  otvorenih  datoteka  OpenOffice.org), 
odaberite Prozor (Window) iz trake izbornika. Ovdje se nalazi 
popis  svih  otvorenih  datoteka,  dostupan iz  svakog  prozora 
programskog alata.

Važno  je  napomenuti  da  se  otvaranjem novog  dokumenta 
stari  ne zatvara,  već samo privremeno sakriva te se može 
ponovno vidjeti na gore navedeni način.
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Jeste li znali...

Sigurno mnoge osobe s kojima surađujete koriste uredski 
paket MS Office. Writer može čitati i spremati dokumente u 
formatu .doc, pa nije potrebno imati instaliran i MS Office 
uz OpenOffice.org. Svakom novom inačicom 
OpenOffice.org paketa poboljšava se kompatibilnost s 
Microsoftovim vlasničkim formatom .doc.
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 2.2.8 Zatvaranje dokumenta

Dokument  je  moguće  zatvoriti  bez  zatvaranja  cijelog 
programskog  alata.  Za  zatvaranje  dokumenta  odaberite 
Datoteka (File) → Zatvori (Close).

Ovisno o tome jesu li se nakon zadnjeg spremanja dogodile 
neke  promjene  na  datoteci,  bit  će  postavljeno  pitanje  o 
spremanju  dokumenta  (vidjeti  poglavlje  Spremanje 
dokumenta).

 2.2.9 Korištenje funkcije pomoći

Cijeli  paket  OpenOffice.org sadrži  sustav  pomoći  koji 
korisnika  prati  u  radu  s  programskim  alatom.  Do  funkcije 
pomoći možete doći:

• putem  trake  izbornika,  Pomoć  (Help)  →  
OpenOffice.org Help,

• putem  alatne  trake,  odabirom  ikone  OpenOffice.org 
Help,

• pritiskom tipke F1.

Novootvoreni prozor sastoji se od dva dijela: s desne strane 
nalazi se tekst pomoći, a s lijeve možete odabrati: 

• Sadržaj  (Contents)  –  pomoć  podijeljena  po  logičkim 
cjelinama – poglavljima,

• Indeks (Index) – lista pojmova u sustavu pomoći,

• Nađi (Find) – pretraživanje pomoći,

• Knjiške  oznake  (Bookmarks) –  lista  korisniku  važnih 
stranica  pomoći.  Stranice  se  na  listu  može  dodati 
korištenjem desne  tipke  miša  na  desnoj  strani  prozora, 
naredbom  Dodaj  u  knjiške  oznake... (Add  to 
bookmarks...).

Pri  radu  s  pojedinim  dijaloškim  okvirom  ili  popisom 
mogućnosti, gumb Pomoć (Help) izravno vodi na dio pomoći 
koji opisuje taj dio programskog alata. 
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Korisna  je  i  opcija  Pomoć  (Help)  →  Što je  ovo?  (What's 
This?) iz trake izbornika, koja strelicu miša pretvara u strelicu 
s oznakom upitnika. Prelaskom takvom strelicom preko nekog 
dijela  programskog  alata,  u  balončiću  pored  strelice 
prikazuje se opis funkcije tog dijela programskog alata.

 2.3 Prilagodba postavki

 2.3.1 Promjena vrste pogleda na dokument

U programskom alatu  Writer  postoje dvije vrste pogleda na 
dokument:

• Izgled ispisa (Print Layout),
• Web izgled (Web Layout).

Izgled ispisa najbolje je koristiti za sve dokumente koji će se 
pregledavati u nekom od samostalnih programskih alata, na 
zaslonu ili koji će biti ispisani na papir. Ovaj pogled prikazuje 
izgled dokumenta na isti ili vrlo sličan način spisu na papir.

Web izgled  je sličniji  izgledu dokumenta nakon objave na 
web stranici, u formatu HTML (HyperText Markup Language). 
Ovaj  izgled  poštuje  neke  od  zakonitosti  HTML-a,  poput 
margina  koje  početno  nisu  postavljene,  smanjivanja  slika 
kako bi stale na zaslon (koji ima definiranu svoju veličinu) i 
slično.

Gotovo uvijek je bolje služiti se pogledom Izgled ispisa.
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Slika 34: 
Sustav pomoći u paketu 
OpenOffice.org

Jeste li znali...

Osim u ugrađenom sustavu pomoći, vrlo je korisno potražiti 
pomoć i na Internetu, korištenjem službene stranice pomoći: 
http://documentation.openoffice.org/ ili nekog od pretraživača 
weba, poput www.google.com. Mnogi korisnici OpenOffice.org 
paketa su često voljni pomoći savjetima na različitim 
diskusijskim grupama i blogovima.
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Postoje posebni programski alati za izradu i uređivanje 
dokumenata u formatu HTML, namijenjenom za prikaz na 
web stranicama. Učinak pretvorbe dokumenata iz 
programskog alata za obradu teksta u HTML najčešće nije 
zadovoljavajući pa većina autora koji objavljuju informacije 
na webu izbjegava taj način.



Postoje još neke mogućnosti promjene pogleda na dokument, 
poput:

• odabira granica teksta (linije koje označavaju područje u 
kojem  je  moguće  pisati  tekst),  putem  trake  izbornika: 
Pogled (View) → Granice teksta (Text Boundaries);

• odabira  ravnala,  mjernog  instrumenta  na  svakoj  strani 
prostora  za pisanje,  koji  pokazuje stvarne udaljenosti  (u 
centimetrima, na primjer) u dokumentu, koje se odabire 
putem trake izbornika: Pogled (View) → Ravnalo (Ruler).

 2.3.2 Povećavanje/zumiranje stranice

Stranice  dokumenta  možete  povećavati  ili  smanjivati  po 
potrebi,  ovisno  o  tome  želite  li  raditi  na  nekom detalju  ili 
gledati  cjelokupni  izgled  stranice.  Za  zumiranje  stranice 
odaberite Pregled (View) → Uvećaj/Zumiraj (Zoom) ili ikonu 

Uvećaj/Zumiraj (Zoom) iz alatne trake.

U prozoru koji se otvori, mogu se odabrati različite veličine 
dokumenta, poput pogleda na cijelu stranicu, povećavanja do 
lijevog i desnog ruba (Širina stranice) ili  nekog od postotka 

stvarne veličine stranice.
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Slika 35: 
Promjena veličine prikaza 
dokumenta

Jeste li znali...

Prostor za pisanje moguće je povećati na veličinu 
cijelog zaslona, sakrivajući sve alatne trake i traku 
izbornika. Ovo je moguće učiniti na dva načina: putem 
trake izbornika: Pogled (View) → Cijeli zaslon (Full 
Screen) ili  kombinacijom tipaka Ctrl + Shift + J.

http://www.google.com/
http://documentation.openoffice.org/


 2.3.3 Prikazivanje i sakrivanje ugrađenih alatnih traka

Na vrhu stranice,  ispod  trake izbornika,  nalaze  se  različite 
alatne trake, grupe ikona za brži rad s programskim alatom, 
grupirane  po  svojoj  namjeni.  Ovisno  o  načinu  i  namjeni 
korištenja  programskog  alata,  svaki  korisnik  može  uključiti 
alatne trake koje su njemu najpotrebnije. Lista alatnih traka 
nalazi  se u traci  izbornika  Pogled  (View)  →  Alatne trake 
(Toolbars).

Najvažnije trake koje su obično uključene su:

• Standardno  (Standard)  -  traka  za  rad  s  datotekama, 
umnožavanje  /  premještanje  teksta  i  pozivanje  važnih 
mogućnosti programskog alata,

• Formatiranje teksta  (Formatting) – traka za uređivanje 
svojstava teksta i grafičkog pisma

• Grafičke oznake i numeriranje (Bullets and Numbering) 
– traka za rad s pobrojanim i nepobrojanim listama

 2.3.4 Prikazivanje i sakrivanje neispisivih znakova

Dokument se, osim uobičajenih, vidljivih znakova, sastoji i od 
nevidljivih,  neispisivih  znakova,  koji  su  obično  pomoć  pri 
oblikovanju dokumenta. Neki od neispisivih znakova su:

• znak početka i završetka odlomka ,
• znak za prijelaz u novi redak ,
• znak prijelaza na novu stranicu ili kolonu,
• znak uvlačenja teksta .

Često je potrebno koristiti mogućnost pregleda ovih znakova, 
jer  je  tako  lakše  upravljati  izgledom  dokumenta.  Dapače, 
korisno  je  što  više  se  naviknuti  na  ove  znakove,  jer 
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Slika 36: Alatna traka Standardno (Standard)

Slika 37: Alatna traka Formatiranje teksta (Formatting)

Slika 38: Alatna traka Grafičke oznake i numeriranje 
(Bullets and Numbering)



olakšavaju shvaćanje načina oblikovanja teksta.

Neispisive znakove možete prikazati ili sakriti na ove načine:
• putem trake izbornika, Pogled (View) → Neispisivi 

znakovi (Nonprinting Characters),
• putem alatne trake, odabirom ikone Neispisivi 

znakovi (Nonprinting Characters).

 2.3.5 Izmjena osnovnih postavki u programskom alatu

Pri radu s bilo kojim programskim alatom, svaki bi ga korisnik 
trebao prilagoditi svojim potrebama. Tako i u programskom 
paketu  OpenOffice.org  i  programskom alatu  Writer možete 
prilagoditi mnoge postavke. One se nalaze u izborniku Alati 
(Tools) → Odrednice (Options).

Za promjenu  korisničkog imena, tj. imena autora, koje će 
inicijalno  pisati  u  svojstvima  svih  korisničkih  dokumenta, 
odaberite  Alati  (Tools)  →  Odrednice  (Options)  → 
OpenOffice.org → Korisnički podaci (User data).

Ovdje  možete  dodati  različite  osobne  podatke,  korisne 
osobama koje će raditi s dokumentom.

Jedna od korisnih prilagodbi je i  promjena primarne mape 
za  otvaranje  i  spremanje  dokumenta,  koja  se  otvara  u 
dijaloškom  prozoru  Otvori  (Open)  i  Spremi  (Save).  Za 
promjenu  navedene  mape  odaberite  Alati  (Tools)  → 
Odrednice (Options) → OpenOffice.org → Putanje (Paths).
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Slika 40: 
Promjena osobnih 
podataka

Slika 39:  
Primjer prikaza 
neispisivih 
znakova



Putanja  koju  treba  promijeniti  naziva  se  Moji  dokumenti 
(My  Documents),  a  za  promjenu  nakon  odabira  odaberite 
gumb Uredi (Edit) te pronađite željenu mapu.
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Prethodno navedene opcije zajedničke su za sve 
programske alate koji se nalaze u paketu 
OpenOffice.org pa ih je dovoljno prilagoditi samo 
jednom.



 2.4 Česta pitanja

Kada koristim naredbu Spremi kao (Save As), a kada 
Spremi (Save)?

Naredbu  Spremi dobro  je  koristiti  kada  staru  inačicu 
dokumenta  ne  treba  čuvati,  na  primjer  pri  manjim 
promjenama. Radite li na nekom većem dokumentu i želite li 
imati  više  inačica,  kako biste  se  mogli  vratiti  "u  prošlost", 
koristite Spremi kao i spremite inačice pod drugim nazivom.

Mogu  li  na  alatne  trake  dodati  neke,  meni  korisne, 
ikone?

Da,  nove ikone  na  alatnu  traku  možete  dodati  na  sljedeći 
način:

1. Odaberite malenu ikonu s trokutićem desno od svake 
alatne trake;

2. Odaberite naredbu Uredi traku s alatima (Customize 
Toolbar);

3. Označavanjem kvadratića odaberite željene ikone. Ako 
ih  nema,  možete  ih  pronaći  odabirom gumba  Dodaj 
(Add).

Zašto  promijeniti  primarnu  mapu  za 
otvaranje/spremanje dokumenata?

Držite li većinu dokumenata unutar jedne mape (neovisno o 
tome  imate  li  podmape),  korisno  je  tu  mapu  proglasiti 
primarnom.  Dolazak  do  željene  mape,  koji  zahtijeva  više 
klikanja mišem, troši dragocjeno vrijeme.
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 2.5 Zadaci za vježbu

1. Pokrenite Writer.

2. Izradite novi dokument. 

3. Promijenite  korisničke  podatke  u  dokumentu,  upišite 
svoje ime, prezime, inicijale i tvrtku.

4. Spremite dokument pod imenom pismo.odt.

5. Promijenite  putanju  primarne  mape  za  otvaranje  i 
spremanje dokumenata na mapu u koju često spremate 
dokumente.

6. Promijenite  veličinu  prikaza  dokumenta  na  uvećanje 
Širina stranice.

7. Napišite nekoliko riječi u dokumentu.

8. Spremite dokument.

9. Izvezite dokument pismo.odtu format PDF, u datoteku 
pismo.pdf.

10.Spremite  dokument  pismo.odt  u  format  DOC 
(Microsoft Word), u datoteku pismo.doc.

11.Spremite  dokument  pismo.odt  u  format  TXT  (Text 
Document),  u  datoteku  pismo.txt.  Čemu  služi  ovaj 
format?

12.Otvorite  izvezenu  datoteku  PDF.  Čemu  služi  ovaj 
format?

13.Zatvorite Writer.
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 3 Osnovne operacije

 3.1 Ciljevi ovog poglavlja

Nakon ovog poglavlja moći ćete:
• umetati tekst,
• označavati dijelove teksta,
• kretati se unutar dokumenta i uređivati tekst,
• koristiti ugrađene funkcije pretraživanja i zamjene riječi.

 3.2 Umetanje teksta

 3.2.1 Umetanje jednostavnog teksta

Tekst se u dokument najčešće unosi korištenjem tipkovnice. 
Osim standardnog unošenja slova, mogu se umetati i brojevi 
te  interpunkcijski  i  slični  znakovi  koji  obično  "dijele"  neku 
tipku s drugim znakom ili slovom. To znači da ih je moguće 
umetnuti pritiskom te tipke, u kombinaciji  s tipkama poput 
Shift ili Alt Gr.

Mjesto  na  kojem će  sljedeći  znak  biti  upisan  označava  se 
pokazivačem (eng. cursor), koji se može pomicati tipkama ili 
mišem (više o tome u sljedećim poglavljima).

Evo nekih preporuka za umetanje teksta: 
• Pri kontinuiranom pisanju teksta, nije potrebno (niti 

preporučeno!) pritiskati tipku Enter za prelazak u novi 
redak. Writer će sam doći do kraja retka i prijeći u novi te 
će pri naknadnoj promjeni teksta sam prebacivati riječi u 
novi redak (ovisno o veličini slova, marginama, itd.). 
Enter se pritišće isključivo ako je potrebno započeti novi 
odjeljak;

• Poslije interpunkcijskih znakova (točka, zarez, uskličnik, 
upitnik, ...) treba slijediti jedan razmak, a nakon razmaka 
nastaviti pisati tekst. Prije interpunkcijskih znakova ne 
stavlja se razmak;

• Tipkom Backspace briše se znak koji se nalazi lijevo od 
pokazivača;
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• Tipkom Del briše se znak koji se nalazi desno od 
pokazivača;

• „Velika slova“ pišu se držanjem tipke Shift za vrijeme 

pritiska slova ili samo jednim pritiskom tipke Caps Lock 
za stalno pisanje "velikih slova". Kada se želi isključiti ta 
mogućnost, ponovno se pritisne tipka Caps Lock;

 3.2.2 Umetanje posebnih znakova

Osim  standardnog  skupa  znakova  koji  se  umeću  putem 
tipkovnice,  postoje  i  posebni  simboli  koji  se  ne  mogu 
jednostavno  dobiti  kombinacijom  tipaka.  Za  njihov  unos 
postoji  poseban  dijaloški  prozor  Posebni  znak  (Special 
Character),  u kojem je moguće pregledati sve znakove koji 
postoje i odabrati željeni. Do ovog se prozora dolazi putem 
trake  izbornika  Ubaci  (Insert)  →  Posebni  znak  (Special 
Character).

Ovdje  je  moguće  odabrati  željenu  vrstu  grafičkog  pisma 
(fonta), kako bi se znak uklopio u ostatak teksta oko njega. 
Znak možete odabrati na dva načina:

• dvostrukim klikom lijeve tipke miša na željeni znak,

• jednostrukim  klikom  lijevom  tipkom  miša  na  željeni 
znak, te potvrdom gumbom U redu (OK).
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Ako pritiskom neke tipke dobijete drugačiji znak nego što 
ste očekivali, moguće je da je jezik tipkovnice promijenjen. 
Tipkovnice za različite jezike imaju neke znakove na 
različitim mjestima pa je potrebno ili promijeniti jezik 
tipkovnice (na  operacijskom sustavu) ili pamtiti promjene 
(ili lijepiti naljepnice na tipkovnicu :-) ).

Slika 41: 
Umetanje posebnih 
simbola

Jeste li znali...

Različite vrste znakova za naglaske (akcente) možete 
dobiti pritiskom kombinacije tipaka Alt Gr + <tipka 
broja pored kojeg se nalazi željeni naglasak>, ako 
nakon te kombinacije odaberete željeno slovo s kojim 
taj naglasak postoji. Na primjer, Alt Gr + 3, te tipka 
"a" daju znak "â".

Jeste li znali...

Korištenjem oznaka pojedinog znaka koje se nalaze u 
prozoru za dodavanje posebnih znakova, moguće ih je 
dobiti i putem tipkovnice. Za to je potrebno imati 
uključen numerički dio tipkovnice (Num Lock), 
pritisnuti i držati tipku Alt  te otipkati 
četveroznamenkasti broj napisan u zagradama. Na 
primjer, kombinacija Alt + 0188 daje znak ¼.  



 

 3.3 Označavanje teksta

Označavanje teksta prvi je korak ka uređivanju teksta. Kako 
biste  na  već  napisani  dio  teksta  primijenili  bilo  kakvo 
oblikovanje,  izbrisali  ga,  premjestili  ili  na  neki  drugi  način 
uredili, potrebno ga je prije toga označiti.

Tekst je moguće označavati korištenjem miša ili tipkovnice. 

Korištenjem miša:

• strelicu miša pomaknite na mjesto od kojeg počinjete 
označavanje,  pritisnite  i  držite  lijevu  tipku  miša  te 
strelicu mišem pomaknite na mjesto gdje želite završiti 
označavanje. Otpustite tipku miša;

• brzim  klikom  lijevom  tipkom  miša  na  neku  od  riječi 
možete dobiti sljedeća označavanja:

• klikom dva puta zaredom: označavanje riječi,
• klikom tri puta zaredom: označavanje rečenice,
• klikom četiri puta zaredom: označavanje 

odlomka;
Korištenjem tipkovnice:

• pomičite se strelicama uz držanje tipke Shift:
• pomicanjem lijevo – desno: označavanje po 

jednog znaka (svakim pritiskom tipke označavanju 
se dodaje po jedan znak),

• pomicanjem gore – dolje: označavanje po jednog 
retka (svakim pritiskom tipke označavanju se 
dodaje po jedan redak);

• pomičite se strelicama uz držanje tipaka Ctrl i Shift:
• pomicanjem lijevo – desno: označavanje po jedne 

riječi (svakim pritiskom tipke označavanju se 
dodaje po jedna riječ),

• pomicanjem gore – dolje: označavanje po jednog 
odlomka (svakim pritiskom tipke označavanju se 
dodaje po jedan odlomak).
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 3.4 Uređivanje teksta

 3.4.1 Uređivanje sadržaja

Osim  umetanja  teksta,  neizbježno  je  znati  i  kako  se  već 
napisani  tekst uređuje,  jer vrlo često autori  nisu zadovoljni 
izgledom  teksta,  primjećuju  pogreške,  žele  nešto  dodati  i 
slično. 

Kako biste mogli uređivati sadržaj, potrebno je znati kako se 
kretati  po  dokumentu  i  doći  do  mjesta  koje  želite  urediti. 
Najlakši  način  kretanja  početnicima  je  korištenje  traka  za 
pomicanje po dokumentu (scroll bars), koje se nalaze s donje 
i  desne strane dokumenta.  Jednom kada na  zaslonu  vidite 
mjesto gdje želimo urediti tekst, pokazivač postavljate na to 
mjesto pomicanjem pokazivača miša i jednim klikom lijevom 
tipkom miša.

Brži način kretanja po dokumentu je korištenje tipkovnice:

• pomicanjem  strelicama  gore,  dolje,  lijevo,  desno: 
pomicanje  za  jedan  znak  lijevo/desno  ili  za  jedan 
redak gore/dolje;

• pomicanjem  strelicama  gore,  dolje,  lijevo,  desno  uz 
držanje  tipke  Ctrl:  pomicanje  za  jednu  riječ 
lijevo/desno ili za jedan odlomak gore/dolje;

• korištenjem  tipaka  Page  Up  (PgUp) i  Page  Down 
(PgDn): pomicanje po tekstu u jednoj visini trenutnog 
teksta na zaslonu;
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Moguće je označiti i cijeli dokument odjednom, na 
sljedeće načine:

• putem trake izbornika: Uređivanje (Edit) → 
Odaberi sve (Select All),

• kombinacijom tipaka Ctrl + A.

Slika 42: 
Označeni tekst



• kombinacijom  tipaka  Ctrl  +  Home  i  Ctrl  +  End: 
pomicanje na početak ili kraj dokumenta.

Iako na početku korištenje tipkovnice može biti teško, nakon 
prilagodbe postiže se puno veća brzina rada pa je  korisno 
uložiti neko vrijeme za vježbu ovog načina kretanja.

Tekst  možete  uređivati  umetanjem  i  pisanjem  preko 
postojećeg teksta. 

Za  umetanje teksta  dovoljno je doći na mjesto gdje treba 
umetnuti  tekst  i  početi  pisati.  Tekst  koji  se  nalazi  nakon 
mjesta  pokazivača  automatski  će  biti  pomaknut.  Kako  bi 
ovakvo uređivanje bilo uspješno, važno je koristiti prijelaz u 
novi red samo onda kada je to doista potrebno, za početak 
novog odlomka.

Pisanje  preko,  odnosno  umjesto  postojećeg  teksta 
možete izvesti na dva načina:

• prethodnim označavanjem dijela teksta koji je potrebno 
prepisati te "normalnim" nastavkom pisanja. Označeni 
tekst automatski će biti prebrisan;

• prelaskom u način za "prepisivanje teksta". U takvom 
načinu,  novi  tekst  neće  pomaknuti  stari,  već  će 
jednostavno  prepisivati  znakove,  nešto  poput  pisanja 
na pisaćem stroju. Ovakav se način može uključiti  na 
dva načina:

• jednim  klikom  miša  u  dijelu  statusne  trake  oko 
sredine, gdje piše INSRT (insert, umetanje teksta). 
Nakon  klika  taj  će  se  tekst  promijeniti  u  OVER 
(overwrite, prepisivanje);

• pritiskom tipke Insert (Ins) na tipkovnici.

Važno  je  da  se  nakon  uređivanja  teksta  u  načinu  pisanja 
preko postojećeg, vratite na standardni način, kako vas ne bi 
iznenadilo nestajanje napisanog teksta.

 3.4.2 Poništavanje izmjena

Prilikom rada na uređivanju dokumenta moguće je da će se 
dogoditi da želite vratiti posljedice zadnje izvršene naredbe, 
bilo  da  ste  je  izvršili  slučajno,  bilo  da  krajnji  rezultat  ne 
odgovara. Vraćanje izmjena ili zadnje naredbe na engleskom 

OpenOffice.org Writer 51



se  jeziku  naziva  Undo,  a  suprotna  operacija,  poništavanje 
vraćanja izmjena Redo.

Programski alat pamti više zadnjih operacija pa se tako nije 
potrebno ograničiti na vraćanje samo jedne operacije, već ih 
se može vratiti više njih. Zadnju operaciju možete vratiti na 
neki od sljedećih načina:

• putem trake izbornika,  Uređivanje (Edit) → Vrati: <ime 
naredbe> (Undo),

• kombinacijom tipaka Ctrl + Z.

Izmjene  napravljene Undo naredbom  (drugim  riječima, 
ponavljanje naredbe koju ipak želimo izvršiti) možete vratiti 
na neki od sljedećih načina:

• putem  trake  izbornika,  Uređivanje (Edit)  →  Ponovi: 
<ime naredbe> (Undo),

• kombinacijom tipaka Ctrl + R.
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 3.5 Umnažanje, premještanje, brisanje

 3.5.1 Umnažanje teksta

U određenim okolnostima, tekst može zahtijevati višekratno 
pisanje istih (ili sličnih) dijelova. Kako ne biste gubili vrijeme 
za pisanje, jednom napisani tekst možete umnožiti na drugo 
mjesto  u  istom  dokumentu  ili  u  drugi  dokument.  Tako 
umnoženi  tekst  kasnije  po  potrebi  možete  prilagođavati  i 
uređivati. 

Tekst  koji  će biti  umnožen prvo treba označiti,  na neki  od 
prethodno navedenih načina. Nakon toga, tekst se kopira u 
međuspremnik računala (Clipboard), Kopirani tekst potom se 
umeće na željeno mjesto. Evo detaljnijeg opisa postupka:

1. Označite željeni tekst.

2. Iskopirajte  ga u međuspremnik  računala  na jedan od 
načina:

• putem trake izbornika, Uređivanje (Edit) → Kopiraj 
(Copy),

• ikonom Kopiraj (Copy) iz alatne trake 
Standardno,

• putem kontekstnog izbornika, naredbom Kopiraj 
(Copy),

• kombinacijom tipaka Ctrl + C;
3. Postavite  pokazivač  na  mjesto  gdje  želite  umetnuti 

tekst.

4. Umetnite tekst iz međuspremnika računala na jedan od 
načina:

• putem trake izbornika, Uređivanje (Edit) → Umetni 
(Paste),

• ikonom Umetni (Paste) iz alatne trake,
• putem kontekstnog izbornika, naredbom Umetni 

(Paste),
• kombinacijom tipaka Ctrl + V.

Ovako je moguće kopirati  i  druge objekte,  poput  tablica ili 
slika.  Više  o  tome  u  poglavlju  Umnažanje  slike,  crteža  i 
grafikona.
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Umnažanje u drugi dokument istovjetno je ovom postupku, 
samo  je  potrebno  otvoriti  drugi  dokument  i  postaviti 
pokazivač na željeno mjesto.

 3.5.2 Premještanje teksta

Premještanje teksta slično je umnažanju, s jedinom razlikom 
što  se  tekst  pri  postavljanju  u  memoriju  briše  s  početnog 
mjesta. Ova mogućnost je značajna jer pri izradi dokumenta 
autori  često  nisu  sigurni  gdje  bi  neki  dio  teksta  najbolje 
odgovarao pa tijekom rada žele promijeniti  redoslijed riječi, 
rečenica ili čitavih odlomaka. 

Tekst koji će biti premješten prvo treba označiti, na neki od 
prethodno navedenih načina. Nakon toga, tekst se premješta 
(za  razliku  od  postupka  umnažanja,  gdje  tekst  ostaje  i  na 
početnom  mjestu!)  u  međuspremnik  računala,  Clipboard, 
Kopirani  tekst  potom  se  umeće  na  željeno  mjesto.  Evo 
detaljnijeg opisa postupka:

1. Označite željeni tekst.

2. Premjestite ga u međuspremnik računala na jedan od 
načina:

• putem trake izbornika,  Uređivanje  (Edit)  →  Izreži 
(Cut),

• ikonom Izreži (Cut) iz alatne trake,

• putem  kontekstnog  izbornika,  naredbom  Izreži 
(Cut),
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Postoji i dodatni način umetanja teksta, s posebnim 
svojstvima, do kojeg se dolazi putem trake izbornika 
Uređivanje (Edit) → Posebno umetni (Paste Special). 
Ovako se sadržaj međuspremnika, ovisno o svom tipu, 
može umetnuti na druge načine (na primjer, bez 
formatiranja, ili formatiran kao HTML). 

Jeste li znali...

Svako postavljanje teksta u međuspremnik (Clipboard) 
uzrokuje brisanje prije postavljenog teksta. Potrebno je 
obratiti pažnju kako uzastopnim kopiranjem (a ne i 
umetanjem na drugo mjesto) ne biste nehotice izgubili 
određeni dio teksta.



• kombinacijom tipaka Ctrl + X.

3. Postavite  pokazivač  na  mjesto  gdje  želite  umetnuti 
tekst.

4. Umetnite tekst iz međuspremnika računala na jedan od 
načina:

• putem trake izbornika, Uređivanje (Edit) → Umetni 
(Paste),

• ikonom Umetni (Paste) iz alatne trake,

• putem  kontekstnog  izbornika,  naredbom  Umetni 
(Paste),

• kombinacijom tipaka Ctrl + V.

Na ovaj način moguće je premjestiti i druge objekte, poput 
tablica ili  slika. Više o tome u poglavlju Premještanje slike, 
crteža i grafikona.

 3.5.3 Brisanje teksta

Tekst  možete  brisati  s  ili  bez  prethodnog  označavanja. 
Brisanje bez prethodnog označavanja pogodnije je za manje 
količine  teksta.  Evo  nekoliko  načina  brisanja  bez 
označavanja:
• tipkom Backspace brišete znak lijevo od pokazivača,
• kombinacijom tipaka Ctrl + Backspace brišete riječ 

lijevo od pokazivača,
• tipkom Delete brišete znak desno od pokazivača,
• kombinacijom tipaka Ctrl + Delete brišete riječ desno 

od kursora.
Za  brisanje  s  označavanjem,  trebate  prvo  označiti  tekst. 
Zatim pritisnite tipku Delete ili Backspace. 
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Postupke umnažanja ili premještanja moguće je napraviti 
i korištenjem miša. Nakon označavanja je metodom 
povlačenja i ispuštanja (drag & drop), kao u radu s 
prozorima ili datotekama, potrebno "odvući" dio teksta 
na drugo mjesto. Izgled strelice miša pritom će na dnu 
dobiti jedan maleni pravokutnik.



 3.6 Pretraga i zamjena teksta

Pretraga teksta pokazuje se jako korisnom pri radu s većim 
dokumentima. Računalo brzo pretražuje velike količine teksta 
po određenim kriterijima, što je za korisnika težak zadatak i 
često ga nije sposoban u potpunosti izvršiti (na primjer, bez 
pogreške pronaći sva pojavljivanja neke riječi u tekstu). Do 
prozora  za  traženje  i  zamjenu  riječi  dolazi  se  na  sljedeće 
načine:
• putem trake izbornika, Uređivanje (Edit) → Pronađi i 

zamijeni (Find and Replace),

• putem alatne trake, klikom na ikonu Pronađi i 
zamijeni (Find and Replace),

• kombinacijom tipaka Ctrl + F.
Prozor sadrži mjesto za upis željene riječi ili fraze te gumbe 
Nađi  (Find) i  Traži sve  (Find All). Ovdje možete upisati dio 
riječi, riječ ili više riječi koju je potrebno pronaći. Gumb Nađi 
nakon pronalaska označava jednu po jednu, pronađenu riječ. 
Pritom trebate odabirati gumb  Nađi  za svaki novu potragu. 
Gumb  Traži  sve  odjednom  će  označiti  sve  odgovarajuće 
riječi u tekstu.

Dvije često korištene opcije koje se u ovom prozoru nalaze 
su:

• Pazi  na VELIKA/mala slova  (Match case):  pretraga  je 
osjetljiva na razliku velikih i malih slova;

• Samo čitave  riječi  (Whole  words  only):  Tražene  riječi 
neće biti  prikazane kao pronađene ako su  dijelovi  neke 
druge riječi.
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Dodatne  opcije,  koje  možete  dobiti  odabirom gumba  Više 
opcija (More Options) su:

• Samo trenutni  odabir  (Current  selection only):  Ako je 
označen neki tekst, pretražuje samo njega;

• Unatrag (Backwards): Za razliku od uobičajene pretrage, 
koja od trenutnog mjesta pokazivača kreće prema kraju 
dokumenta, uz ovu opciju pretraga kreće prema vrhu;

• Regularni izrazi  (Regular expressions):  Regularni  izrazi 
poseban su način zapisa skupa sličnog teksta, korištenjem 
definiranih  pravila.  Ovaj  vrlo  moćan  alat  omogućuje 
pronalazak  npr.  različitih  gramatičkih  oblika  neke  riječi, 
tekst  sastavljen  samo  od  brojeva,  riječi  koje  počinju 
slovom "a" a završavaju slovom "k" i slično;

• Pretraga  sličnosti  (Similarity  search):  Ovaj  alat 
omogućuje pronalazak sličnih riječi zamjenom određenog 
broja znakova, te uklanjanjem ili dodavanjem nekog broja 
znakova.  Korištenje  je  jednostavnije  nego  korištenje 
regularnih  izraza,  no  regularni  izrazi  su  moćniji  u 
definiranju tražene riječi;

• Traži  stilove  (Search  for  Styles):  Mogućnost  pretrage 
teksta ne po određenoj riječi, već po stilu pisanja teksta 
(po  naslovima,  podnaslovima,  slikama,  itd.)  Više  o 
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Mali trud učenja regularnih izraza može biti vrlo isplativ. 
Evo nekoliko korisnih oznaka i primjera za pretragu:

  Znak: Zamjenjuje: Primjer:
   . Bilo koji znak mu.a → muka, muha
   .* Bilo koji skup znakova mu.*a → mudra, muka, 
mušica
   [ ] Jedan od znakova mu[hk]a → 
muka, muha (ne i muža!)
   \< Početak riječi \<mu → mudrost (ne i 
dijagramu!)
   \> Kraj riječi \>mu → njemu (ne i 
mudrost!)

Slika 45: 
Dodatne mogućnosti



stilovima u poglavlju Primjena oblikovanja teksta.

Zamjena teksta

Pronađene  riječi  mogu  se  automatski  zamijeniti  u  istom 
prozoru za pretragu. Tekst kojim želite zamijeniti pronađenu 
riječ upišite u polje  Zamijeni s  (Replace with). Postoje dva 
gumba za zamjenu:

• Zamijeni  (Replace):  Zamjena  samo  trenutno 
pronađenog / označenog pojma;

• Zamijeni  sve  (Replace  All):  Automatska  zamjena  svih 
pronađenih pojmova.

 3.7 Česta pitanja

Kako mogu saznati  koliko riječi  ili  znakova postoji  u 
dokumentu?

Statistiku  dokumenta  možete  pronaći  u  izborniku  Alati 
(Tools)  →  Brojač riječi  (Word Count).  Ondje se nalazi broj 
znakova i  riječi  u označenom dijelu  dokumenta i  u  cijelom 
dokumentu. Dodatno, opširnija  statistika postoji  u izborniku 
Datoteka (File) → Svojstva (Properties). Tu je naveden i broj 
odlomaka, linija, tablica, slika i slično.

Kako mogu automatski spremati svoj dokument?

Korisnici  često  pri  duljem radu zaborave redovito  spremati 
dokument. Automatsko spremanje dokumenta vrlo je važna 
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mogućnost koja "spašava" dokument prilikom "smrzavanja" 
programskog alata ili čitavog operacijskog sustava. Obično se 
postavlja na vremenski period od 10 ili 15 minuta. U slučaju 
smrzavanja  programskog  alata  ili  čitavog  operacijskog 
sustava, pri sljedećem pokretanju, bit će pokrenut oporavak 
dokumenta, a izgubljene će biti samo promjene od zadnjeg 
automatskog spremanja. Ovu mogućnost možete postaviti u 
dijaloškom prozoru  Alati  (Tools)  →  Odrednice  (Options)  → 
Učitaj/Spremi  (Load/Save)  →Općenito  (General) →  Snimi 
SamoObnova informacije svako <broj_minuta> minuta 
(Save  AutoRecovery  information  every 
<number_of_minutes> minutes).

Kako mogu pisati tekst dokumenta u više kolona?

Postavke vezane za stupce određuju se u dijaloškom prozoru 
Oblik (Format) → Stupci (Columns). Ovdje možete definirati 
u koliko stupaca treba podijeliti tekst, koja je širina stupaca te 
postoji li i kako izgleda linija koja ih razdvaja.

 3.8 Zadaci za vježbu

1. Izradite novi dokument. 

2. U dokumentu napišite sljedeći tekst (znak ° za stupanj 
možete  dobiti  iz  prozora  Posebni  znak  ili 
kombinacijom tipaka  AltGr + 5 te pritiskom još jedne 
tipke (C):

Recept za čokolino

Sastojci:

0,2 l mlijeka

30 g čokolina

Priprema: 

Grijati  mlijeko  dok  ne  prokuha.  Ohladiti  do 
temperature  50°C.  U  mlijeko  dodati  čokolino. 
Miješati  dok  se  ne  dobije  gusta  kaša.  Pojesti  s 
užitkom!

3. Spremite dokument pod nazivom cokolino.odt.

OpenOffice.org Writer 59



4. Označite cijeli recept te ga umnožite ispod postojećeg, 
u jednoj kopiji.

Zadaci 5 – 7 odnose se na umnoženi recept.

5. Ručno promijenite riječ "Sastojci" u riječ "Potrebno".

6. Korištenjem prozora  za  zamjenu  riječi  zamijenite  sve 
pojave  riječi  "čokolino"  riječju  "frutolino".  Što  se 
dogodilo s rječju "čokolina"?

7. Korištenjem prozora  za  zamjenu  riječi  zamijenite  sve 
pojave  dijela  riječi  "čokolin"  riječju  "frutolin".  Što  se 
dogodilo s rječju "čokolina"?

8. Spremite dokument pod nazivom doručak.odt.
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 4 Oblikovanje 

 4.1 Ciljevi ovog poglavlja

Nakon ovog poglavlja moći ćete:
• primijeniti osnovna oblikovanja teksta,
• primijeniti stilove oblikovanja,
• koristiti ugrađeno rastavljanje riječi,
• oblikovati odlomke,
• oblikovati stranice.

 4.2 Oblikovanje teksta

Oblikovanje teksta svojstvo je programskih alata za obradu 
teksta, koji osim upisa samih znakova tekst mogu prikazati 
na  različite  načine:  korištenjem  različitih  oblika  slova, 
veličina,  razmještajem  teksta  i  slično.  Ovako  dokument 
dobiva  svoja  vizualna  obilježja,  koja  prenose  i  naglašavaju 
određene poruke (istaknute riječi i slično).

 4.2.1 Promjena vrste i veličine grafičkog pisma

Vrsta  i  veličina  grafičkog  pisma  (fonta)  jako  utječu  na 
čitljivost dokumenta, stoga ih je potrebno pažljivo odabrati. 
Veličinu grafičkog pisma možete promijeniti iz padajućeg 
izbornika u alatnoj traci Formatiranje (Format). 

Tip  grafičkog  pisma  također  možete  promijeniti  iz 
padajućeg izbornika u alatnoj traci  Formatiranje (Format). 
Obično se u jednom dokumentu koristi  samo jedan font,  ili 
manji  broj  grafičkih  pisama -  fontova.  Najčešće se odabire 
jedno  serif grafičko pismo (sa slovima ukrašenim na kraju, 
poput Times New Roman) i jedno sans-serif grafičko pismo (bez 
ukrasa, poput Arial).
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Postavke možete promijeniti i na sljedeće načine:

• korištenjem prozora Oblik (Format) → Znak (Character) i 
njegove kartice Pismo (Font),

• naredbom  Pismo  (Font) i Veličina  (Size) iz kontekstnog 
izbornika  (klik  desnom  tipkom  miša  nad  označenim 
tekstom).

 4.2.2 Primjena oblikovanja teksta

Tri  su  najvažnija  tipa  oblikovanja  teksta,  koji  se  nalaze  u 
gotovo  svim  programskim  alatima  za  bilo  kakav  rad  s 
tekstom: podebljavanje, nakošavanje i podcrtavanje teksta.

Za oblikovanje prethodno napisanog teksta, potrebno ga je 
prvo označiti. Želite li oblikovanje primijeniti na tekst koji će 
tek  biti  napisan,  dovoljno  je  primijeniti  neku  od  sljedećih 
metoda, bez označavanja.

Tekst možete podebljati (Bold):

• ikonom Masno iz alatne trake Formatiranje,

• kombinacijom tipaka Ctrl + B.

Tekst možete nakositi (Italic):

• ikonom Kurziv iz alatne trake Formatiranje,

• kombinacijom tipaka Ctrl + I.

Tekst možete podcrtati (Underline):

• ikonom Podcrtano iz alatne trake Formatiranje,

• kombinacijom tipaka Ctrl + U.

Dodatni načini kako možete promijeniti oblikovanje su:

• korištenje prozora Oblik (Format) → Znak (Character) i 
njegove kartice Pismo (Font),

• naredba Stil (Style) iz kontekstnog izbornika.
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 4.2.3 Pisanje indeksa i eksponenata

Znakovi ne moraju uvijek biti  smješteni u istu razinu linije. 
Writer  podržava pisanje  eksponenata  i  indeksa, pri čemu 
se  znakovi  postavljaju  iznad  ili  ispod  uobičajene  razine 
teksta  u  retku.  Takve  je  znakove  najlakše  napisati  na 
uobičajeni  način,  a  kasnije  ih  pretvoriti  u  indekse  i 
eksponente,  korištenjem  prozora  Oblik  (Format)  →  Znak 
(Character) i njegove kartice Položaj (Position).

Ovdje  se  nalaze  tri  gumba  za  odabir:  Eksponent 
(Superscript),  Obično  (Normal)  te  Indeks  (Subscript),  koji 
definiraju vodoravni položaj znakova. 

Dodatni način za pisanje indeksa i eksponenata je korištenje 
kontekstnog izbornika i njegove opcije Stil (Style).

 4.2.4 Promjena malih slova u velika i obratno

U  već  napisanom tekstu  velika  se  slova  mijenjaju  u  mala 
putem trake izbornika  Oblik (Format) → Velika/mala slova 
(Change Case).

U  mini-izborniku  Velika/mala  slova  moguće  je  odabrati 
treba li se napisani tekst pretvoriti u sva velika ili sva mala 
slova. Prethodno je potrebno označiti željeni tekst.

Dodatni  način za promjenu velikih/malih  slova  je korištenje 
kontekstnog  izbornika  i  njegove  opcije 
Velika-mala-slova/znakovi.
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 4.2.5 Bojanje teksta

Boju  teksta  moguće  je  promijeniti  korištenjem ikone  
Boja  pisma (Font Color)  iz  alatne  trake  Formatiranje 
(Formatting).  Pokraj  gumba  se  nalazi  strelica,  čijim  se 
odabirom  pojavljuje  skup  boja  iz  kojeg  možemo  izabrati 
željenu boju.

Dodatni način za promjenu oblikovanja je korištenje prozora 
Oblik (Format) → Znak (Character) i njegove kartice Efekti 
na pismu (Font Effects).

 4.2.6 Kopiranje oblikovanja s jednog dijela teksta na 
drugi

Osim kopiranja teksta, moguće je kopirati samo oblikovanje 
teksta na drugi, ovim postupkom:

1. Označite tekst čije oblikovanje želite kopirati;

2. Iz  alatne  trake,  odaberite  ikonu Oblikuj  slikarski 

kist (Format PaintBrush);

Izgled strelice miša promijenit će se u izgled kista.

3. Takvom strelicom označite tekst na koji želite kopirati, 
odnosno primijeniti isto oblikovanje.

Napredniji način rada s oblikovanjima je korištenje stilova.
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 4.2.7 Primjena postojećeg stila

Stil  je  skup  oblikovanja  (vrsta,  boja  i  veličina  slova, 
poravnanje  teksta...),  koji  se  primjenjuje  na  neke  dijelove 
teksta. Važno je razumjeti da stilovi označavaju semantičke 
grupe podataka, a ne samo načine oblikovanja. Na primjer, 
stilovi mogu označavati:

• naslove, podnaslove,

• istaknuti tekst,

• pojmove na različitim jezicima,

• citate.

Uzmite za primjer rad na ovom priručniku: u njemu postoji 
mnogo  naziva  naredbi,  na  hrvatskom  i  engleskom  jeziku, 
označenih  na  određeni  način.  Moguće  je  da  se  pred  kraj 
izrade  priručnika  odluči  nazive  na  engleskom  jeziku 
prikazivati podcrtano, a ne ukošeno. Provođenje u djelo takve 
odluke zahtijevalo bi više sati posla, kada bi se svaki pojam 
mijenjao  ručno.  Moguće  je  da  svi  pojmovi  ne  bi  bili 
zamijenjeni,  jer  je  teško  pratiti  sve  na  vrlo  velikom 
dokumentu.

Primjer ovakve izrade dobar je primjer za korištenje stilova. 
Sve su naredbe na engleskom označene stilom  naziveng, a 
sve naredbe na hrvatskom stilom nazivhrv. Svaka promjena 
oblikovanja na stilu vrši se samo jednom, na jednom mjestu, 
a  svi  se pojmovi  označeni  tim stilom automatski  ažuriraju, 
kako bi bili u skladu s novim oblikovanjem. Tako se promjena 
iz  ukošenog  u  podcrtano  oblikovanje  svodi  na  nekoliko 
naredbi mišem, u desetak sekundi.

Četiri  su  vrste  stilova  u  programskom  alatu  OpenOffe.org 
Writer:

• stilovi odlomka (npr. Tijelo teksta, Naslov 1, Naslov 2),

• stilovi znakova (npr. Uobičajeno, Istaknuto, Primjer),

• stilovi okvira (npr. Formula, Grafika),

• stilovi stranice (npr. Uobičajeno, Prva stranica, Desna 
stranica, Lijeva stranica).

Stilove je moguće promijeniti na sljedeće načine:
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• iz padajućeg izbornika stilova odlomka, u alatnoj traci 
Formatiranje (Formatting),

• iz  prozora  Stilovi  i  formatiranje  (Styles  and 
Formatting), u kojem se nalaze sve četiri vrste stilova 
do kojeg se dolazi pritiskom tipke F11.

Za promjenu stila potrebno je odabrati dio teksta te odabrati 

stil.  Stilovi  omogućavaju  brzo  i  jednostavno  naknadno 
uređivanje teksta, daju tekstu dosljedno oblikovanje te čine 
izgled oblikovanja teksta profesionalnijim.

Unaprijed  definirano  oblikovanje  stilova  možete  promijeniti 
odabirom naredbi Izmijeni (Modify) iz kontekstnog izbornika 
stila  u  prozoru  Stilovi  i  formatiranje.  Tako  izgled 
dokumenta možete prilagoditi vlastitim potrebama.
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Možete  dodavati  i  vlastite  stilove,  odabirom naredbe  Novi 
(New) iz  kontekstnog izbornika stila na kojem želite graditi 
novi stil. Osim odabira naziva novog stila, u ovom se prozoru 

definira izgled stila. 

 4.2.8 Automatsko rastavljanje riječi

Moderni  programski  alati  za  obradu  teksta  upravljaju 
slaganjem riječi na sljedeći način: na kraju retka, riječ koja 
nije stala u taj redak cijela prelazi u novi red. No, moguće je 
koristiti i rastavljanje riječi crticom (hyphenation).  Pritom će 
dio iza crtice prijeći u novi redak teksta. Iako nije uobičajeno 
pri pisanju teksta koristiti ovaj način rastavljanja, on može biti 
dobar u određenim situacijama, poput novinskih članaka koji 
imaju malu širinu (a često dugačke riječi), opisa slika i slično. 

Rastavljanje riječi može biti automatsko ili ručno (na zahtjev). 

Automatsko rastavljanje možete definirati  na željenom stilu 
oblikovanja, na sljedeći način:

1. Odaberite  naredbu  Izmijeni  (Modify) iz  kontekstnog 
izbornika stila,

2. Odaberite karticu Tijek teksta (Text Flow),

3. Označite  opciju  Rastavljanje  riječi  (Hyphenation): 
Automatski (Automatically).

Ručno  rastavljanje  pokrećete  putem trake  izbornika,  Alati 
(Tools)  →  Jezik  (Language)  →  Rastavljanje  riječi 
(Hyphenation).

U  prozoru  koji  se  pojavljuje,  pruža  vam  se  mogućnost 
provjere svakog rastavljanja, koje je bilo potrebno.
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Stilove možete učitati i iz drugog dokumenta, naredbom 
Učitaj stilove (Load Styles) iz mini izbornika u gornjem 
desnom kutu prozora Stilovi i formatiranje. Tako 
možete uskladiti grafički izgled dokumenata.
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 4.3 Oblikovanje odlomka

 4.3.1 Umetanje i pomicanje oznaka odlomka

Odlomak  je  skup  rečenica  koje  čine  smislenu  cjelinu, 
vizualno odvojen od ostalih elemenata u dokumentu. Koristite 
li pregled neispisivih znakova, često možete vidjeti znakove 
za  kraj/početak  odlomka  ¶.  Oblikovanje  teksta  se  najviše 
oslanja  na  načelo  podjele  u  odlomke,  pa  je  potrebno 
razumjeti čemu odlomci služe i kako mogu pomoći u radu. 

Pritiskom  tipke  Enter završava  dotadašnji,  a  počinje  novi 
odlomak.  Odlomci  imaju  mnoga  svojstva  koja  se  mogu 
definirati, bilo da se definiraju za svaki odlomak pojedinačno, 
bilo  da  se  za  to  koriste  stilovi,  što  je  pri  ozbiljnijem  radu 
svakako preporučljiv način.

 4.3.2 Umetanje i pomicanje oznaka za kraj reda

Kraj reda, odnosno prelazak u "novi red" pri pisanju teksta na 
računalu  se  obično  ne  koristi,  kako  je  već  objašnjeno  u 
poglavlju o umetanju teksta. No, ako doista postoji potreba za 
prelaskom  u  novi  red,  a  da  se  pritom  ne  prijeđe  u  novi 
odlomak, možete dodati oznaku za kraj reda, na ove načine:

• putem  trake  izbornika,  Ubaci  (Insert)  →  Ručni  prekid 
(Manual Break) → Prekid linije (Line Break),

• kombinacijom tipaka Shift + Enter.

Napomena:  Ovu  oznaku  treba  koristiti  isključivo  kada  ste 
sigurni  da  znate  što  radite,  nikako  kao  zamjenu  za  novi 
odlomak, ili još gore, umjesto automatskog prelaska teksta u 
novi reda pri  uobičajenom pisanju! Korisnici  koji  su radili  na 
pisaćem stroju se moraju naviknuti na novi način razmišljanja 
pri korištenju programskih alata za obradu teksta.
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 4.3.3 Poravnavanje teksta

Odlomak teksta možete vodoravno poravnati na četiri načina:
• lijevo,
• centrirano,
• desno,
• obostrano.

Poravnavanje  se  uvijek  odnosi  na  cijeli  odlomak,  a  ne 
primjerice na pojedinu riječ ili redak u odlomku.

Dodatni načini kako možete promijeniti poravnanje su:
• korištenje prozora Oblik (Format) → Odlomak 

(Paragraph) i njegove kartice Poravnanje (Alignment),
• naredbom Poravnanje (Alignment) iz kontekstnog 

OpenOffice.org Writer 71

Slika 56: 
Prelazak u "novi redak"

Slika 57: 
Ikone za 
poravnavanje

Slika 58: Vrste poravnavanja odlomka

Jeste li znali...

Za uobičajeno pisanje odlomaka teksta, bolje je koristiti 
obostrano nego lijevo poravnavanje. Obostrano 
poravnavanje djeluje urednije.



izbornika.

 4.3.4 Uvlačenje odlomka

Uvlačenje  odlomka  predstavlja  načine  vizualnog  odnosa 
prema drugim odlomcima i  marginama (granicama) teksta. 
Postoje četiri vrste uvlačenja:

• lijevo – cijeli se odlomak pomiče prema desno, a na lijevoj 
strani je prazan prostor;

• desno  -  cijeli  se  odlomak  pomiče  prema  lijevo,  a  na 
desnoj strani je prazan prostor;

• prva linija – prva linija pomiče se udesno;

• sve osim prve linije  – sve se linije  osim prve pomiču 
udesno  (ovo  se  uvlačenje  može  postići  negativnim 
uvlačenjem prve linije);

Uvlačenje  odlomka  uređuje  se  u  prozoru  Odlomak 
(Paragraph), na sljedeći način:

1. Otvorite prozor Odlomak:
• putem trake izbornika, Oblik (Format) → Odlomak 

(Paragraph),
• iz kontekstnog izbornika, odabirom naredbe 

Odlomak;
2. Otvorite karticu Uvlake i razmaci (Indents & Spacing);

3. Promijenite  veličine  Prije  teksta,  Poslije  teksta  i 
Prva linija. 
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Za općenito lakši rad s odlomcima, s obzirom na to da 
se dio opcija određuje apsolutnom veličinom – 
centimetrima – korisno je naviknuti se koristiti ravnala 
s mjerama lijevo i iznad teksta.



U  veličinama  je  dozvoljeno  upisati  negativne 
vrijednosti. Pri promjeni jako pomaže prikaz izgleda na 

desnoj strani prozora.

 4.3.5 Odabir vrste proreda

Prored (razmak između redaka u odlomku) može biti različit. 
Obično  se  koristi  jednostruki  prored,  no  neki  slučajevi 
zahtijevaju posebnu veličinu proreda, često 1.5. 

Prored  unutar  odlomka  uređuje  se  u  prozoru  Odlomak 
(Paragraph), na sljedeći način:

1. Otvorite prozor Odlomak (Paragraph):

• putem trake izbornika,  Oblik  (Format) →  Odlomak 
(Paragraph),

• iz  kontekstnog  izbornika,  odabirom  naredbe 
Odlomak (Paragraph);

2. Otvorite karticu Uvlake i razmaci (Indents & Spacing);

3. Iz  padajućeg  izbornika  Razmak između linija  (Line 
spacing) odabweite željeni razmak:

• Jednostruko,

• 1.5 redak,

• Dvostruko,

• Razmjerno – u odnosu na veličinu slova,

• Najmanje – minimalni razmak u centimetrima,
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• Naslovno – apsolutni razmak u centimetrima.

 4.3.6 Odabir razmaka ispred i iza odlomka

Razmak između odlomaka međusobno određujete na sličan 
način:

1. Otvorite prozor Odlomak:

• putem trake izbornika,  Oblik  (Format) →  Odlomak 
(Paragraph),

• iz  kontekstnog  izbornika,  odabirom  naredbe 
Odlomak (Paragraph);

2. Otvorite karticu Uvlake i razmaci (Indents & Spacing);

3. Odaberite  željene  vrijednosti  iz  izbornika  Prored: 
Iznad odlomka i Ispod odlomka;

 4.3.7 Rad s tabulatorima

Prva asocijacija na riječ "tabulator" obično je tipka  Tab  na 
tipkovnici,  kojom se  prelazi  na  sljedeći  element  u  prozoru 
nekog programskog alata ili pravi nešto širi razmak u tekstu. 
No,  tabulatori  u  programskim  alatima  za  obradu  teksta 
proširuju  funkciju  izrade  razmaka  u  tekstu.  Korištenjem 
tabulatora, točnije oznaka za granice tabulatora (tab stops), 
moguće je  lakše uređivati  dokument u kojemu je  tekst  na 
određen način poredan, na primjer, za izradu obrazaca.

Granica tabulatora označava gdje će se pokazivač premjestiti 
pritiskom tipke  Tab. Ako se granice tabulatora ne postave, 
pritisak tipke Tab premjestit će pokazivač uvijek za jednaku, 
unaprijed  postavljenu  udaljenost.  Postoje  četiri  tipa 
tabulatora:

• lijevi – od ovog mjesta tekst će se pisati udesno,

• desni – od ovog mjesta tekst će se pisati ulijevo,
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Prored prije i nakon odlomka bolje je rješenje za ostavljanje 
praznog mjesta prije i nakon novog poglavlja od ručno 
stvorenih "novih redaka", pritiskom tipke Enter dva puta. 
Primijenimo li veličinu praznog mjesta na određeni stil u 
cijelom dokumentu, vrijeme potrebno za naknadno 
uređivanje dokumenta jako se smanjuje.



• centralni  –  od  ovog  mjesta 
tekst  će  se  ravnomjerno 
rasporediti  s  obje  strane 
granice,

• decimalni – decimalni brojevi 
napisani  ispod  ovog 
tabulatora bit će poravnati po decimalnoj točki.

Dodatna je mogućnost u radu s tabulatorima popunjavanje 
praznog  prostora  koji  se  dobiva  prelaskom  na  granicu 
sljedećeg  tabulatora.  Takav  prostor  može  ostati  prazan  ili 
automatski  biti  ispunjen  točkama  (.....),  crticama  (------), 
podctrama (_____) ili bilo kojim drugim znakom.

Upravljanje  tabulatorima  vrši  se  iz  prozora  za  rad  s 
odlomcima. Evo kako možete dodati granicu tabulatora:

1. Otvorite prozor Odlomak:

• putem trake izbornika,  Oblik  (Format) →  Odlomak 
(Paragraph),

• iz  kontekstnog  izbornika,  odabirom  naredbe 
Odlomak;

2. Otvorite karticu Tabulatori (Tabs);

3. Odaberite gumb Novi (New);

4. Podesite njegovu udaljenost od lijevog ruba;

5. Odaberite  tip  tabulatora  (lijevi,  desni,  centralni, 
decimalni);

6. Odaberite ispunu do sljedećeg tabulatora.

U  ovom  je  prozoru  možete  i  mijenjati  svojstva  trenutno 
postojećih tabulatora, te ih brisati.

Drugi  način dodavanja tabulatora je putem ravnala koje se 
nalazi iznad dijela programskog alata za prikaz dokumenta. 
Jednim klikom lijeve tipke miša na željeno mjesto na ravnalu 
dodaje se lijevi tabulator i njegov znak. Klikom desne tipke 
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miša na neki od tabulatora u ravnalu možete iz kontekstnog 
izbornika promijeniti tip tabulatora.

Dvostruki klik na željeno mjesto na ravnalu izravno vodi na 
karticu  Tabulatori  (Tabs) prozora  Odlomak  (Paragraph), 
gdje  možete  detaljnije  uređivati  tabulatore  (npr.  precizno 
odrediti njihovu udaljenost).

Tabulator možete obrisati putem ravnala odvlačenjem oznake 
granice tabulatora izvan ravnala.

 4.3.8 Označavanje i numeriranje

Liste ili popisi česti su elementi tekstova, potrebni za različite 
vrste nabrajanja.  Nabrajanje  može biti  pobrojano (važan je 
poredak  elemenata)  ili  nepobrojano  (elementi  se  smatraju 
jednako  "važnima").  Nepobrojano  nabrajanje  naziva  se  i 
grafičko označavanje  (bullets), a pobrojano  numeriranje 
(numbering).

Za dodavanje nabrajanja trebate učiniti sljedeće:

1. Otvorite prozor Grafičke oznake i numeriranje:

• putem trake izbornika,  Oblik  (Format) →  Grafičke 
oznake i numeriranje (Bullets and Numbering),

• iz  kontekstnog  izbornika,  odabirom  naredbe 
Grafičke oznake i numeriranje.

2. Odaberite neku od kartica:

• Grafičke  oznake  –  jednostavne  grafičke  oznake, 
nepobrojana lista;

• Tip numeriranja – lista uređena brojkama i slovima;

• Grafike – neuređena lista, oznake su male sličice;

3. Po odabiru željenog izgleda, potvrdite odabir.
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Ručno izrađivanje obrazaca, a posebno njihovo 
uređivanje, vrlo je mučno. Dovoljno je dodati samo 
nekoliko slova da se ručno dodane crtice ili točke koje 
"glume" polja potpuno poremete. Tabulatori su idealni 
za ovu namjenu.



Slika 63: 
Pregled tipova 
numeriranja

Poslije dodavanja će redak u kojem se nalazi pokazivač na 
početku imati željenu oznaku. Nakon upisivanja teksta, u novi 
redak  možete  prijeći  tipkom  Enter,  a  nova  se  oznaka 
automatski dodaje novom retku.

Brz način dodavanja označavanja i numeriranja je putem 
korištenja ikona:

Numeriranje uključeno/isključeno (Numbering 
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Liste mogu imati više razina nabrajanja. Svaka razina 
može imati svoj način označavanja, a moguće je i 
kombiniranje pobrojanih i nepobrojanih lista. Odabir 
ovakvih lista vršite iz kartice Kontura (Outline) 
prozora Grafičke oznake i numeriranje (Bullets and 
Numbering). Za prelazak na sljedeću (ili prethodnu) 
razinu treba koristiti tipku Tab ili kombinaciju Shift + 
Tab.
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On/Off) i 
Grafičke oznake uključeno/isključeno (Bullets On/Off) 

iz alatne trake.

Već napisani tekst u obliku liste, gdje je svaki element 
napisan u svom retku, moguće je pretvoriti u označavanje ili 
numeriranje primjernom gorenavedenog postupka uz 
prethodno označavanje svih elemenata liste.

 4.3.9 Mijenjanje stila oznaka i brojeva

Stil  izrađene  liste  možete  jednostavno  mijenjati.  Samo  je 
potrebno označiti listu (ili neku njenu razinu) te otvoriti prozor 
Grafičke oznake i numeriranje (Bullets and Numbering) u 
kojem možete izvršiti promjenu stila. Prelazak iz nepobrojane 
u pobrojanu listu i obratno vrlo je jednostavan.

 4.3.10 Dodavanje ruba, okvir i sjenčanje odlomka

Moguće je da u tekstu postoje odlomci koje treba posebno 
istaknuti,  poput  odlomaka  "Jeste  li  znali.."  u  ovoj  knjizi. 
Odlomak  je  moguće  istaknuti  na  više  načina,  poput 
dodavanja ruba, okvira, pozadine ili sjenčanja odlomka. Sve 
ove mogućnosti nalaze se u prozoru Odlomak (Paragraph), do 
kojeg se dolazi:

• putem  trake  izbornika,  Oblik  (Format)  →  Odlomak 
(Paragraph),

• iz  kontekstnog izbornika,  odabirom naredbe  Odlomak 
(Paragraph).
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Kartica  Pozadina  (Background)  definira  pozadinu odlomka, 
koja može biti boja ili slika koja se nalazi na računalu.

Kartica  Rubovi  (Borders)  definira  rub,  okvir  i  sjenčanje 
odlomka.  Na  lijevoj  je  strani  pet  unaprijed  definiranih  i 
najčešće  korištenih  rasporeda  linija  –  rubova.  Možete 
definirati  i  vlastiti  raspored, odabirom pojedinačnih stranica 
odlomka  na  malom primjeru  slike.  Ovdje  možete  postaviti 
oblik, debljinu i boju ruba te udaljenost od sadržaja. Odlomak 
može imati i  sjenu, za koju možete odabrati  smjer padanja 
svjetlosti, veličinu sjene i boju. 
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 4.4 Oblikovanje dokumenta

Oblikovanje  dokumenta  podrazumijeva  pripremu  samih 
stranica  dokumenta  za  pregled  ili  ispis.  Ovo  oblikovanje 
najvećim dijelom možete obaviti iz prozora Stranica (Page), 
kojeg je moguće otvoriti:

• putem  trake  izbornika,  Oblik  (Format)  →  Stranica 
(Page),

• iz  kontekstnog izbornika, odabirom naredbe  Stranica 
(Page).

 4.4.1 Prijelomi stranice u dokumentu

Prijelom ili prekid stranice u dokumentu služi za nastavljanje 
pisanja  teksta  na  početku  nove  stranice.  Tako  obično 
započinju nova poglavlja najviše razine, no mogu postojati i 
mnogi drugi razlozi za nastavak na novoj stranici. Nikako nije 
preporučljivo  do  prijeloma  stranice  doći  uzastopnim 
pritiskanjem tipke  Enter i stvaranja "praznih novih redova". 
Razlog je jednostavan: broj tako napravljenih novih redova je 
stalan.  Dodavanjem  novog  teksta  prije  ove  praznine 
poremetit će se ostatak teksta, a novi tekst neće početi na 
vrhu, već će sav tekst biti pomaknut prema dolje. Ispravan 
prijelom  stranice  koji  se  prilagođava  kasnije  dodanom 
sadržaju, umećete na sljedeći način:

• putem trake izbornika,  Ubaci (Insert) → Ručni prekid 
(Manual Break) → Prijelom stranice (Page Break),
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I stranice mogu imati različite stilove pa tako možete 
posebno definirati izgled "desnih" i "lijevih" stranica, 
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stranica, ne morate se brinuti npr. oko izgleda 
podnožja na različitim vrstama stranica.
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Ovakvo uređivanje odlomka lako možete definirati u 
jednom od stilova, čime postižete usklađivanje izgleda 
odlomaka koje je potrebno istaknuti.



• kombinacijom tipaka Ctrl + Enter.

 4.4.2 Promjena orijentacije dokumenta i veličine stranice

Unutar  prozora  Stranica  (Page)  i  kartice  Stranica  (Page) 
nalaze se opcije za promjenu veličine i orijentacije stranice. 
Padajući izbornik  Oblik  (Format) sadrži unaprijed definirane 
formate stranica s visinom i širinom (poput A4, B5...). Želite li 
sami  definirati  veličinu,  to možete upisivanjem podataka u 
polja Visina (Height) i Širina (Width).

Orijentacija  (usmjerenje)  stranice  može  biti  portretno 
(uspravno, Portrait) ili pejzažno (položeno, Landscape). Sâmi 
nazivi  opisuju  izgled i  svrhu orijentacije  stranice:  uspravne 
stranice imaju veću visinu od širine pa su pogodne primjerice 
za portrete, dok položene stranice imaju veću širinu od visine, 
pa su pogodne primjerice za pejzaže.
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 4.4.3 Promjena margina

Margine  su  prostor  koji  odvaja  sadržaj  od  ruba  stranice. 
Svaka  margina  može  biti  različite  širine,  što  je  primjerice 
pogodno, na primjer,  za uvezivanje dokumenata, s obzirom 
da obično  margina  uz  uvez  mora  biti  veća  kako bi  nakon 
uveza  bila  približno  ista  kao  margina  suprotne  strane). 
Margine se izražavaju apsolutnim vrijednostima (najčešće u 
centimetrima).  Promjenu  margina  također  vršite  u  prozoru 
Stranica (Page) i kartici Stranica (Page).
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 4.4.4 Zaglavlje i podnožje dokumenta

Zaglavlje i  podnožje  dokumenta područja su na vrhu i  dnu 
stranice u kojima se obično nalaze informacije poput naslova 
teksta ili poglavlja, autora, broja stranice i sličnog. Izgled ovih 
polja isti je ili sličan na svim stranicama, što vam omogućuje 
da ih uredite na samo jednoj stranici, a posao umnažanja (ili 
promjene, poput broja stranica) prepustite računalu. 

Dodavanje  i  uređivanje  zaglavlja  i  podnožja  dokumenta 
možete napraviti unutar prozora  Stranica (Page). Oba polja 
imaju  vlastitu  karticu,  Zaglavlje  (Header)  te  Podnožje 
(Footer),  s  istovjetnim  svojstvima.  Kako  bi  se  zaglavlje  / 
podnožje  vidjelo,  trebate  označiti  opciju  Zaglavlje  / 
Podnožje uključeno (Header / Footer On). Ovdje definirate 
svojstva poput margina, proreda i visine zaglavlja / podnožja. 
Gumb  Više  (More)  daje  mogućnost  definiranja  rubova, 
sjenčanja i pozadina zaglavlja / podnožja.

Zaglavlje i podnožje možete dodati i putem trake izbornika:

• Ubaci  (Insert)  →  Zaglavlje  (Header)  → (stil  stranice na 
koju treba dodati zaglavlje),

• Ubaci  (Insert)  →  Podnožje  (Footer)  →  (stil  stranice  na 
koju treba dodati podnožje).

Dodavanjem  zaglavlja  i  podnožja  svaka  stranica  sadrži 
odvojen prostor na vrhu i dnu u koji možete upisati željene 
informacije. Sve će se ručno upisane informacije pojaviti na 
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svakoj stranici ovog stila.

 4.4.5 Polja u zaglavlju i podnožju dokumenta

Najveća  korisnost  zaglavlja  i  podnožja  dokumenta  leži  u 
poljima  čiji  se  sadržaj  automatski  generira  i  prilagođava 
svakoj stranici, poput broja trenutne stranice, ukupnog broja 
stranica dokumenta ili naslova poglavlja. Za dodavanje polja 
trebate  pozicionirati  pokazivač  u  podnožje  ili  zaglavlje,  na 
mjesto na kojem trebate unijeti polje. 

Polja se unose putem trake izbornika, Ubaci (Insert) → Polja 
(Fields) → (naziv polja).

Neka od najkorisnijih polja su:
• Datum (Date),
• Broj stranice (Page Number),
• Numeriranje stranica (Page Count) - ukupan broj 

stranica dokumenta.
Dodatna se polja mogu ubaciti putem trake izbornika, Ubaci 
(Insert) →  Polja (Fields) →  Ostalo  (Other). Ovdje se nalaze 
polja poput elemenata dokumenta, (npr. poglavlja), referenci 
(npr. slike, tablice) te naprednih tipova poput varijabli ili veza 
na baze podataka.  Evo primjera  dodavanja  broja  i  naslova 
trenutnog poglavlja u zaglavlje knjige:

1. Postavite pokazivač u zaglavlje stranice;
2. Otvoriti prozor za odabir polja putem trake izbornika, 

Ubaci (Insert) → Polja (Fields) → Ostalo (Other);
3. Odaberite karticu Dokument (Document);
4. Odaberite tip Poglavlje (Chapter);
5. Odaberite željeni oblik (npr. Broj i ime poglavlja 

(Chapter number and name));
6. Odaberite razinu (sloj) poglavlja koju treba prikazati;
7. Potvrdite odabir gumbom Ubaci (Insert).

Još jedan primjer polja trenutni je naziv datoteke. Dodavanje 
je  jednako  gornjem,  osim  što  se  polje  nalazi  u  kartici 
Dokument (Document), tipu Ime datoteke (File name}.

Sva polja u dokumentu označena su sivom nijansom kako bi 
se  razlikovala  od  teksta  koji  je  unio  korisnik.  Sve  gore 
navedeno  možete  primijeniti  i  na  polja  u  običnom  tekstu, 
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točnije,  nije  nužno  da  ta  polja  budu  u  zaglavlju/podnožju 
stranice.

 4.4.6 Automatsko numeriranje

Automatsko  numeriranje  stranica  dijelom  je  objašnjeno  u 
prethodnom  poglavlju.  Ako  je  potrebno  na  različitim 
stranicama  imati  različito  "ponašanje"  numeriranja,  poput 
početka  numeriranja  od  nekog  broja,  stranice  koja  ne 
prikazuje numeriranje i slično, trebate koristiti stilove stranica 
(poput Prva stranica, Lijeva stranica, Desna stranica...). 
Tako  je  moguće  točno  odrediti  gdje  i  kako  prikazati  broj 
stranice,  u  ovisnosti  o  vrsti  stranice.  Dodatna  pomoć  je  i 
prozor  Ubaci  (Insert)  →  Ručni  prekid  (Manual  Break).  U 
njemu  se  određuje  na  koji  je  stil  potrebno  prijeći  nakon 
ubacivanja  prijeloma stranice.  Tu  se  može  odrediti  hoće  li 
neki stil imati broj stranice te od kojeg će broja početi.

 4.5 Česta pitanja

Kako mogu napraviti tablicu sadržaja?

Tablicu sadržaja poglavlja možete napraviti putem dijaloškog 
prozora  Ubaci  (Insert)  →  Indeksi  i  tablice  (Indexes  and 
Tables)  →  Indeksi  i  tablice  (Indexes  and  Tables).  Ovdje 
možete odabrati koliko je razina potrebno prikazati te kako će 
tablica  izgledati.  Osim tablice sadržaja,  korisni  su i  indeksi 
(popisi)  ilustracija/tablica. Tip tablice odaberite iz padajućeg 
izbornika Tip (Type).

Kako  mogu  postići  da  broj  stranice  bude  u  obliku 
"Trenutni broj / Ukupni broj"?

Postavite  pokazivač  u  podnožje  stranice.  Odaberite  Ubaci 
(Insert) →  Polja  (Fields)  →  Broj stranice  (Page Numbers). 
Desno od toga upišite znak " / " te odaberite Ubaci (Insert) → 
Polja (Fields) → Numeriranje stranice (Page Count).

Kako  mogu  odabrati  vlastitu  grafičku  oznaku  za 
natuknice?

Posebnu  grafičku  oznaku  za  natuknice  možete  odabrati  iz 
kartice Odrednice (Options) dijaloškog prozora Alati (Tools) 
→ Grafičke oznake i numeriranje (Bullets and Numbering). 
Ovdje se nalazi gumb Odabir (Select) pomoću kojeg možete 
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odabrati  ili  oznaku iz Galerije ili  datoteku koja se nalazi na 
nekom mediju.
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 4.6 Zadaci za vježbu

1. Otvorite  dokument  dorucak.odt  napisan u zadacima 
prošlog poglavlja.

2. Promijenite vrstu grafičkog pisma za riječi "Potrebno" i 
"Priprema" u Arial, te podebljajte ove riječi.

3. Promijenite  vrstu  grafičkog  pisma za  sastojke  i  tekst 
načina pripreme u Times New Roman.

4. Na naslov recepta primijenite centrirano oblikovanje.

5. Na  tekst  načina  pripreme  primijenite  obostrano 
oblikovanje.

6. Korištenjem  naredbe  Velika/mala  slova  promijenite 
sva slova naslova u velika slova.

7. Sastojke napišite u obliku nepobrojane liste (natuknica), 
s oznakama kvačica.

8. Na  samom  početku  dokumenta  napišite  "Recepti  za 
doručak". Na ovaj tekst primijenite stil Naslov.

9. Na svaki od naslova "Recept za čokolino" / "Recept za 
frutolino" primijenite ova oblikovanja odlomka:

○ svijetložuta boja pozadine,

○ rubovi odlomka,

○ prored između redaka 1.5.

10.Ubacite ručni prekid stranice prije početka recepta za 
frutolino.

11.Provjerite je li format stranice A4. Postavite margine na 
2 cm sa svake strane.

12.U  zaglavlje  dokumenta  unesite  naslov  dokumenta  s 
lijeve strane te ime i prezime autora s desne strane.

13.U podnožje dokumenta unesite broj stranice.
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 5 Objekti

 5.1 Ciljevi ovog poglavlja

Nakon ovog poglavlja moći ćete:
• izraditi tablicu,
• uređivati i naknadno dodavati elemente tablice,
• oblikovati tablicu,
• unositi slike i grafikone,
• premještati slike i grafikone,
• mijenjati veličinu slika i grafikona.

 5.2 Tablice

 5.2.1 Izrada tablice za unos teksta

Iako je osnovna namjena programskog alata  Writer obrada 
teksta, u njemu je moguće prikazivati jednostavnije tablične 
podatke, uređivati ih, sortirati pa čak i obavljati jednostavne 
izračune.  Za  složenije  tablične  podatke,  poput  statističkih 
podataka,  trebate  koristiti  neki  od  specijaliziranih 
programskih alata za tablične kalkulacije, poput programskog 
alata Calc, također iz paketa OpenOffice.org.

Tablicu možete izraditi na dva načina:

• putem trake izbornika, Tablica (Table) → Ubaci (Insert) → 
Tablica (Table):

• u novootvorenom prozoru Umetni tablicu (Insert Table) 
upišite ime tablice, te broj redaka i stupaca,

• označavanjem opcije Naslov (Heading) možete dodati 
posebni redak s naslovima stupaca. Taj se redak može 
ponavljati nakon određenog broja redaka, što je korisno 
ako podataka ima više nego što može stati na jednu 
stranicu,

• odabirom Bez dijeljenja tablice (Don't split table) 
omogućujete da se tablica ne prelomi na kraju stranice, 
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već da u cijelosti prijeđe na sljedeću stranicu,
• opcijom Rub (Border) dodajete obrub svim ćelijama 

tablice. Rub je moguće postaviti i na drugom mjestu, 
nakon izrade tablice.

• odabirom  ikone  Tablica  (Table)  iz  alatne  trake 
Standardno:

• odabirom  glavnog  dijela  ikone  otvarate  prethodno 
opisani prozor Umetni tablicu (Insert Table),

• odabirom  trokutića  desno  od  ikone  započinjete 
jednostavan  način  umetanja  tablice,  određivanjem 
njenih dimenzija.

 5.2.2 Umetanje i uređivanje podataka u tablici

Tekst  se  u  polja  (ćelije)  tablice  umeće  kao  da  se  radi  o 
običnom tekstu. Za upisivanje teksta u nekoj ćeliji potrebno je 
da se pokazivač nalazi u njoj. S obzirom da se radi o tabličnim 
podatcima,  olakšano  je  kretanje  po  tablici,  koje  se,  osim 
mišem, može obaviti i tipkovnicom. Evo nekoliko kratica:
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• strelice – pomicanje unutar ćelije ili na sljedeću ćeliju 
ako se pokazivač nalazi na kraju ćelije;

• tipka  Tab  –  prelazak  na  desnu  susjednu  ćeliju  ili  u 
sljedeći redak, ako se radi o posljednjoj ćeliji u retku;

• kombinacija  tipaka  Shift  +  Tab  -  prelazak  na  lijevu 
susjednu ćeliju ili prethodni redak, ako se radi o prvoj 
ćeliji u retku.

Unutar tablice možete koristiti gotovo sve vrste oblikovanja, 
dodavati slike, odlomke i slično.

 5.2.3 Označavanje tablice i elemenata tablice

Pojedinačna ćelija tablice označava se tako da se označi njen 
sadržaj. Uređivanje i oblikovanje jedne po jedne ćelije tablice 
nije učinkovito, posebno ako se radi o istoj vrsti oblikovanja, 
poput  postavljanja  ruba  ili  pozadina  ćelija.  Zato  postoji 
mogućnost  označavanja  redaka  i  stupaca  te  cijele  tablice, 
kako  bi  oblikovanje  bilo  odjednom  primijenjeno  na  sve 
označene elemente. 

Elementi  se  mogu označiti  putem trake izbornika,  Tablica 
(Table) → Označi (Select) → (željeni element).

Označavanje korištenjem miša izvodi se na sljedeći način:
• postavljanjem strelice miša lijevo od retka mijenjate 

oblik strelice u vodoravnu deblju strelicu. Klikom 
lijevom tipkom miša označavate taj redak, a pomicanjem 
strelice gore-dolje uz držanje tipke miša označavate i 
dodatne retke;

• postavljanjem strelice miša iznad stupca mijenjate oblik 
strelice u okomitu deblju strelicu. Klikom lijevom 
tipkom miša označavate taj stupac, a pomicanjem 
strelice lijevo-desno uz držanje tipke miša označavate i 
dodatne stupce;

• postavljanjem miša gore lijevo od prve ćelije 
označavate cijelu tablicu.
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Označavanje  korištenjem  tipkovnice  moguće  je  sljedećim 
kombinacijama:

• Ctrl + A – označavanje ćelije (ako ima neki sadržaj). 
Pritisak još jednog slova "A" uz držanje tipke Ctrl 
označava cijelu tablicu;

• Shift + strelice – označavanje ćelije i susjednih ćelija.

 5.2.4 Umetanje i brisanje retka i stupca

Načini umetanja retka i stupca istovjetni su; stoga će ovdje 
biti  naveden postupak dodavanja retka. Za stupce je samo 
potrebno odabrati naredbe drugačijeg naziva). Redak možete 
dodati na sljedeći način:

• putem trake izbornika, Tablica (Table) → Ubaci (Insert) 
→ Retci (Rows),

• iz kontekstnog izbornika unutar ćelije, odabirom naredbe 
Redak (Row) → Ubaci (Insert),

• odabirom ikone Umetni red (ili Umetni stupac) iz 
alatne trake Tablica (Table).

U  slučaju  korištenja  nekog  od  prva  dva  načina,  otvara  se 
prozor  Umetni (Insert Table) u kojem možete odrediti  broj 
(iznos) redaka i stupaca koje je potrebno umetnuti. Također, 
trebate  odrediti  hoće  li  retci/stupci  biti  umetnuti  prije  ili 
poslije  retka  /  stupca  ćelije  u  kojoj  se  pokazivač  trenutno 
nalazi.

Brisanje redaka i stupaca slično je dodavanju. Retke brišete:

• putem  trake  izbornika,  Tablica  (Table)  →  Obriši 
(Delete) → Retci (Rows),

• iz  kontekstnog  izbornika  unutar  ćelije,  odabirom 
naredbe Redak (Row) → Obriši (Delete),

• odabirom ikone Obriši red (ili Obriši stupac) 
iz alatne trake Tablica (Table).
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 5.2.5 Promjena širine stupca i visine retka

Načela promjene širine stupca i visine retka su različita, što 
proizlazi iz naravi samih tabličnih podataka. 

Nakon izrade tablice,  svi  su stupci  iste  širine.  Širina  se ne 
mijenja  s  unošenjem  teksta.  Za  promjenu  širine  stupca 
trebate slijediti ove korake:

1. Otvorite prozor Širina stupca (Column Width):

• putem  trake  izbornika,  Tablica  (Table)  → 
SamoPrilagođavanje  (Autofit) →  Širina stupca 
(Column Width),

• iz  kontekstnog  izbornika  unutar  ćelije,  odabirom 
naredbe Stupac (Column) → Širina (Width);

2. Odaberite širinu kojeg stupca treba mijenjati;

3. Upišite željenu širinu u centimetrima.

Optimalna  je  širina  stupca  ona  u  kojoj  nema  preširokih 
stupaca koji imaju prazan prostor nakon upisanog sadržaja. 
Širinu  stupca  možete  optimirati  se  na  neki  od  sljedećih 
načina:

• putem  trake  izbornika,  Tablica  (Table)  → 
SamoPrilagođavanje  (Autofit)  →  Optimalna  širina 
stupca (Optimal Column Width),

• iz kontekstnog izbornika unutar ćelije, odabirom naredbe 
Stupac (Column) → Optimalna širina (Optimal Width).

Nakon izrade tablice, visina redaka dovoljna je za jedan redak 
teksta.  Širina  se  može  automatski  mijenjati  s  dodavanjem 
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teksta.  Za  promjenu  visine  redaka  trebate  slijediti  ove 
korake:

1. Otvorite prozor Visina retka (Row Height):

• putem  trake  izbornika,  Tablica  (Table)  → 
SamoPrilagođavanje  (Autofit)  →  Visina  retka 
(Row Height),

• iz  kontekstnog  izbornika  unutar  ćelije,  odabirom 
naredbe Redak (Row) → Visina (Height);

2. Upišite željenu visinu u centimetrima;

3. Po želji odaberite opciju Prilagodi veličini (Fit to size), 
koja  će  povećavati  visinu  retka  ako  visina  sadržaja 
prijeđe upisanu visinu.

Optimalna je visina retka ona u kojoj nema previsokih redaka 
(koji  imaju  prazan prostor  ispod upisanog sadržaja).  Visine 
redaka možete optimirati na neki od sljedećih načina:

• putem  trake  izbornika,  Tablica  (Table)  → 
SamoPrilagođavanje  (Autofit)  →  Optimalna  visina 
Retka (Optimal Row Height),

• iz kontekstnog izbornika unutar ćelije, odabirom naredbe 
Redak (Row) → Optimalna visina (Optimal Width).
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Popularan način za uređivanje dimenzija redaka i 
stupaca je korištenje miša. Strelicom trebate uhvatiti 
granicu između dva retka ili dva stupca, te je povući na 
željenu dimenziju.

Slika 79: 
Promjena visine retka

Slika 80: 
Promjena visine retka 
korištenjem miša



 5.2.6 Promjena stila, boje i širine okvira ćelije

Prilikom  oblikovanja  odlomka,  i  u  tablicama  je  moguće 
mijenjati svojstva okvira. Moguće je da različite ćelije imaju 
različita svojstva okvira, pa čak i da samo pojedine stranice 
okvira budu drugačije.

Ovisno  o  tome  koje  rubove  treba  mijenjati,  potrebno  je 
označiti  elemente  (ćelije,  retke,  stupce,  tablice).  Prozor  za 
promjenu svojstava okvira,  Format tablice,  (Table Format) 
otvara se na sljedeće načine:

• putem  trake  izbornika,  Tablica  (Table)  →  Svojstva 
tablice (Table Properties),

• iz  kontekstnog  izbornika  unutar  elemenata  tablice, 
odabirom naredbe Tablica (Table).

U kartici Rubovi (Borders) treba odabrati:

• raspored linija – koje sve linije označenog objekta treba 
iscrtati;

• stil i boju linije;

• razmak do sadržaja;
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Traka alata Tablica, koja se prikazuje kada se 
pokazivač nalazi unutar tablice, brz je način promjene 
svojstava rubova. Potrebno je označiti željene 
elemente i koristiti ikone za promjenu stila, boje te 
odabir željenih rubova.

Slika 81: 
Promjena svojstava 
rubova elemenata 
tablice



Zanimljiva  je  mogućnost  korištenje  unaprijed  definiranih 
stilova  tablice,  tzv.  SamoOblikovanje,  do  kojeg  se  dolazi 
putem trake izbornika, Tablica (Table) → SamoOblikovanje 
(AutoFormat).  Ovdje jednim klikom miša možete promijeniti 
čitavu  tablicu,  uključujući  pozadine,  vrste  i  boju  slova  i 
dodatna oblikovanja.

 5.2.7 Sjenčanje tablice

Tablicu  je,  kao  i  odlomak,  možete  osjenčati  u  prozoru  za 
promjenu svojstava okvira,  Format tablice  (Table Format), 
kojeg otvarate na sljedeće načine:

• putem trake izbornika, Tablica (Table) → Svojstva 
tablice (Table Properties),

• iz kontekstnog izbornika unutar elemenata tablice, 
odabirom naredbe Tablica (Table).

Ovdje možete odabrati smjer pada svjetlosti, veličinu sjene i 
boju. Sjenčanje je moguće primijeniti samo na cijelu tablicu, a 
ne i na pojedinačne ćelije. 
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U prozoru SamoOblikovanje možete napraviti i vlastite 
formate – oblike tablica, kako bi sve tablice u 
dokumentu imale jednoobrazan izgled.

Slika 82: 
SamoOblikovanje tablice – 
oblik "Plava"



 5.3 Slike, crteži i grafikoni

 5.3.1 Umetanje slike, crteža i grafikona u dokument

Dodatni važan izvor informacija u dokumentu su i slike, crteži 
i grafikoni. Pod pojmom slika se u ovoj knjizi podrazumijeva 
grafički  objekt  koji  se  nalazi  u  ugrađenoj  galeriji,  a  pod 
pojmom crtež grafička datoteka na tvrdom disku (ili drugom 
mediju) koja se unosi putem pretraživanja resursa.

Programski alat Galerija omogućava brz unos već postojeće 
slike iz paketa OpenOffice.org u dokument. Nakon instalacije 
tamo  se  nalaze  primjeri  različitih  vrsta  pozadina,  manjih 
znakova, strelica i slično. Galeriji možete pristupiti na neki od 
sljedećih načina:

• putem trake izbornika, Alati (Tools) → Galerija (Gallery),
• putem alatne trake Crtanje (Drawing), odabirom ikone

Galerija (Gallery).

U galeriji se s lijeve strane nalaze grupe objekata, kao što su 
Grafičke oznake, Pozadine ili  Ravnala,  a s desne su strane 
prikazani objekti  unutar grupe. Postupak dodavanja slike je 
sljedeći:

1. Željeni objekt odaberite desnom tipkom miša;

2. Iz  kontekstnog  izbornika  odaberite  Ubaci (Insert)  → 
Kopiraj (Copy);

3. Nakon što se slika pojavi na sredini trenutnog retka u 
dokumentu,  prenesite  ga  na  željeno  mjesto  i 
promijenite veličinu, ako je potrebno.

Crtež u dokument možete umetnuti putem:

• trake izbornika, Ubaci  (Insert) →  Slika (Picture) →  Iz 
datoteke (From File), 
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• odabirom ikone Iz datoteke u alatnoj traci Crtanje 
(Drawing).

Otvara se uobičajeni prozor za pretragu datotečnog sustava i 
pronalaženje  datoteke.  Korisno  je  označiti  opciju  Pregled 
(Preview)  koja  prikazuje  umanjen  prikaz  crteža,  što  vam 
pomaže u odabiru prave slike. 

Grafikon grafički  prikazuje  tablične podatke.  Ako su podaci 

napisani  u  tablicama  u  programskom  alatu  Writer, 
najjednostavnije  je  napraviti  grafikon  upravo  iz  ovog 
programskog alata. 

Grafikon se izrađuje na sljedeći način:

1. Označite  ćelije  unutar  tablice  koje  trebate  grafički 
prikazati.

2. Započnite  izradu  grafikona  putem  trake  izbornika, 
Ubaci (Insert) → Objekt (Object) → Grafikon (Graph).

Otvorit će se prozor SamoOblikovani graf.

3. Ako  ste  u  prvom  koraku  označili  redak  ili  stupac  s 
oznakama naslova tabličnih podataka, trebate označiti 
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Odabirom opcije Link, slika će biti umetnuta kao veza na 
datoteku. Ako uređujete sliku, sliku neće biti potrebno 
ponovno umetati u dokument, već će promjene odmah biti 
vidljive. Pritom kod slanja ili prijenosa dokumenta morate 
poslati ili uzeti sa sobom i sve slike, jer inače neće biti 
prikazane u dokumentu.

Slika 84: 
Umetanje crteža



opcije  Prvi  redak  /  stupac  kao  tekst  opisa. 
Odaberite gumb Dalje >>.

4. Odaberite tip grafikona, uz odabir trebaju li se podaci 
prikazivati po stupcima ili po retcima. Odaberite gumb 
Dalje >>.

5. U  sljedećem  koraku  možete  odabrati  varijanta  vrste 
grafikona  te  jesu  li  potrebne  crte  rešetke  po 
koordinatnim osima. Odaberite gumb Dalje >>.

6. U zadnjem koraku trebate definirati  različite postavke: 
naziv  grafikona,  natpise  na  osima,  te  postojanje 
legende. Za izradu grafikona odaberite gumb Napravi.
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Slika 85: 
Prvi korak izrade 
grafikona

Slika 86: 
Drugi korak izrade 
grafikona

Slika 87: 
Treći korak izrade 
grafikona



Grafikon se u dokumentu prikazuje u obliku objekta te ga, 
kao  i  druge  objekte,  možete  umnažati  i  premještati. 
Dvostrukim klikom na grafikon prelazite u oblik programskog 
alata za uređivanje grafikona, što možete vidjeti po posebno 
prilagođenim alatnim trakama. Unutar ovog prikaza možete 
promijeniti sve prije navedene opcije za izradu grafikona.
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Slika 88: 
Četvrti korak izrade 
grafikona

Jeste li znali...

Prilikom korištenja slika, važno je paziti na autorska 
prava i uvjete korištenja slike! 

Slika 89: 
Primjer izrađenog grafikona



 5.3.2 Umnažanje slike, crteža i grafikona 

Umnažanje je korisno kada je potrebno isti objekt prikazati na 
više mjesta u dokumentu ili njegovu kopiju umetnuti u drugi 
dokument. Kako ne biste uvijek ponovno umetali sliku ili crtež 
te ponovno pisali isti tekst, možete umnožiti već postojeće. 
Za umnažanje je prvo potrebno klikom lijevom tipkom miša 
na njegovu površinu označiti objekt (svejedno je radi li se o 
slici,  crtežu  ili  grafikonu).  Objekt  će  postati  označen  sivim 
obrubom,  s  osam zelenih  kvadratića.  Tako  označen  objekt 
možete umnožiti na sljedeće načine:

• odabirom  naredbe  Kopiraj  (Copy)  iz  kontekstnog 
izbornika, odlaskom na željeno mjesto u dokumentu te 
odabirom  naredbe  Umetni  (Paste)  iz  kontekstnog 
izbornika;

• odabirom  naredbe  Uređivanje  (Edit)  →  Kopiraj 
(Copy),  odlaskom na  željeno  mjesto  u  dokumentu  te 
odabirom  naredbe  Uređivanje  (Edit)  →  Umetni 
(Paste);

• premještanjem  objekta  metodom  povlačenja  i 
ispuštanja (drag & drop) uz držanje tipke Ctrl.

Moguće je da će se u prva dva načina umetnuti objekt nalaziti 
na istom mjestu kao i originalni pa ga je potrebno premjestiti 
na željeno mjesto.

 5.3.3 Pomicanje slike, crteža i grafikona u drugi 
dokument

Premještanje  je  korisna  mogućnost  pri  uređivanju 
dokumenta,  s  obzirom  na  to  da  često  trenutni  raspored 
objekata nije optimalan. Premještanje je slično umnažanju, no 
pritom neće biti  izrađena kopija objekta, već će se početni 
objekt premjestiti na novo mjesto.

Za premještanje je prvo potrebno označiti objekt. Objekt će 
se označiti sivim obrubom, s osam zelenih kvadratića. Tako 
označen objekt možete premjestiti:

• odabirom  naredbe  Izreži  (Cut)  iz  kontekstnog 
izbornika, odlaskom na željeno mjesto u dokumentu te 
odabirom  naredbe  Umetni  (Paste)  iz  kontekstnog 
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izbornika;

• odabirom naredbe  Uređivanje  (Edit)  →  Izreži  (Cut), 
odlaskom na željeno mjesto u dokumentu te odabirom 
naredbe Uređivanje (Edit) → Umetni (Paste);

• premještanjem  objekta  metodom  povlačenja  i 
ispuštanja  (metodom  drag  &  drop)  –  označiti  objekt, 
tako  da  strelica  miša  poprimi  oblik  križića  te  ga 
premjestiti na željeno mjesto.

 5.3.4 Promjena veličine slike, crteža ili grafikona

Promjena  veličine  objekata  se,  kao  i  umnažanje  i 
premještanje,  često  koristi  za  uređivanje  rasporeda 
elemenata stranice. 

Za  premještanje  je  prvo  potrebno  označiti objekt,  klikom 
lijevom  tipkom  miša  na  njegovu  površinu.  Objekt  će  se 
označiti  sivim  obrubom,  s  osam  zelenih  kvadratića. 
Povlačenjem nekog od kvadratića promijenit će se veličina te 
slike  crteža  ili  grafikona.  U  slučaju  povlačenja  kutnog 
kvadratića, bit će promijenjene obje susjedne veličine.

Nekoliko važnih savjeta: 

• malena slika koju previše povećavate bit će vrlo zrnata i 
neće izgledati dobro,

• pri povlačenju kutnog kvadratića, slika se može izobličiti, 
odnosno, može se narušiti omjer duljine i širine, ovisno o 
smjeru povlačenja,

• ako pri  povlačenju  kutnog kvadratića  držite  tipku  Shift, 
omjer duljine i širine objekta bit će sačuvan pa neće doći 
do izobličenja.
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Promjena veličine slike



 5.3.5 Razmještanje slike, crteža ili grafikona

Nakon unosa slike, crteža ili grafikona, logično je pitanje kako 
smjestiti  objekt  u  dokument.  Prvi  razmještanju  objekta 
najvažnije su dvije stvari: 

• Omatanje teksta oko objekta – u kakvom će odnosu 
biti objekt i obližnji tekst,

• Sidrenje objekta – s kojim će dijelom dokumenta pri 
razmještaju objekt biti povezan.

Postoje sljedeće vrste omatanja teksta oko objekta:

• Ništa (Ometanje isključeno),

• Prije,

• Nakon,

• Paralelno (Omatanje stranice),

• Kroz (Omatanje kroz),

• Optimalno.

Tekst možete omotati oko slike na sljedeće načine:
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Veličinu slike možete promijeniti i odabirom naredbe 
Slika (Picture) iz kontekstnog izbornika slike, u kartici 
Tip (Type). Ovdje možete odrediti apsolutnu veličinu 
slike.

Slika 91: Tipovi 
omatanja stranice, u 
kartici Omatanje



• putem  trake  izbornika,  Oblik  (Format)  →  Slike... 
(Picture...), kroz karticu Omatanje (Wrap), 

• iz  kontekstnog  izbornika  slike,  odabirom  naredbe  Slika 
(Picture), kroz karticu Omatanje (Wrap), 

• iz kontekstnog izbornika slike, odabirom jednog od načina 
omatanja iz podizbornika Omatanje teksta (Wrap), 

• odabirom jedne od ikona za omatanje iz alatne 

trake  OLE – Objekti,  koja  će  se  pojaviti  kada  označite 
sliku.

Sidrenjem objekta  povezujete objekt i neki od elemenata 
dokumenta. Ponekad slika treba biti vezana za neku stranicu, 
ponekad za odlomak, ponekad je važno da bude upravo na 
nekom  mjestu  u  tekstu.  Pri  promjeni  izgleda  dokumenta 
(prijenosi  teksta  na  novu  stranicu,  dodavanje  teksta,  na 
primjer), potrebno je da tako vezane slike ostanu vezane, tj. 
usidrene, kako bi se sačuvao razmještaj objekata na stranici.

Objekt možete usidriti:
• na stranicu,
• na odlomak,
• na znak,
• kao znak – objekt postaje kao jedan od znakova u tekstu.

Sliku možete usidriti na sljedeće načine:
• putem trake izbornika, Oblik (Format) → Slike... 

(Picture...), kroz karticu Tip (Type),
• iz kontekstnog izbornika slike, odabirom naredbe Slika 

(Picture), kroz karticu Tip (Type), 
• iz kontekstnog izbornika slike, odabirom jednog od 

načina omatanja iz podizbornika Sidrenje objekta 
(Anchor Object), 

• odabirom jednog od načina sidrenja iz trokutića pored 

ikone Promijeni sidro (Anchor) iz alatne trake 
OLE – Objekti, koja će se pojaviti kada označite sliku.
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 5.3.6 Brisanje slike, crteža i grafikona

Brisanje  svih  objekata  (tekst,  slika,  crtež)  provodi  se  na 
istovjetan  način.  Prvo  trebate  označiti  objekt,  a  zatim 
pritisnuti  tipku  Delete  na  tipkovnici  ili  odabrati  naredbu 
Izreži (Cut) iz kontekstnog izbornika.

 5.4 Česta pitanja

Kako mogu napisati opis/naslov slike?

Opis slike možete jednostavno napisati odabirom dijaloškog 
prozora Opis (Caption) iz kontekstnog izbornika slike. Writer 
će  se  pobrinuti  za  automatsko  numeriranje  slika,  a  ovdje 
možete  izabrati  kojim  imenom  će  se  slike  nazivati  (Slika, 
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Sidrenje objekta 
kroz karticu Tip

Jeste li znali...

U kartici Tip (Type) za sidrenje objekta možete 
definirati i apsolutni ili relativni položaj objekta u 
odnosu na detaljnije opisani objekt sidrenja. Npr. objekt 
se može nalaziti na vrhu stranice, lijevo poravnat.

Jeste li znali...

Gore navedeni opisi razmještanja slike vrijede i za 
druge objekte: grafikone i crtane objekte. Pritom je 
ponekad umjesto naredbe Slika potrebno koristiti 
naredbu Objekt (Object), no cijeli postupak je 
identičan.



Ilustracija,  Figure...).  Ako  pišete  dokument  s  mnogo  slika, 
korisno je na kraju dodati i popis slika (vidjeti Česta pitanja 
3).

Kako mogu dodati obrub slici?

Obrub  se  dodaje  putem  dijaloškog  prozora  kao  i  kod 
odlomaka.  Prozor  se  nalazi  na  kartici  Rubovi  (Borders), 
dijaloškog  okvira  Slika  (Picture)  u  kontekstnom  izborniku 
slike.

Kako mogu računati s podacima u tablici?

Za jednostavno računanje  u  tablici  treba  odabrati  naredbu 
Tablica  (Table)  →  Formula  (Formula).  Ispod  traka  alata 
otvorit će se nova traka za upis formule. Sve formule počinju 
znakom  "=".  polja  se  označavaju  kao  npr.  <A1>,  <B3>. 
Ikona Formula u ovoj traci daje padajući izbornik s različitim, 
unaprijed pripremljenim formulama. Za naprednije računske 
operacije koristite Calc.
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Slika 93: 
Računanje u tablici



 5.5 Zadaci za vježbu

1. Otvorite novi dokument.

2. Napravite  tablicu 
dimenzija 3x3.

3. U  tablicu  unesite  sljedeće 
podatke:

4. Označite cijelu tablicu i promijenite veličinu teksta na 
16.

5. Umetnite novi redak na dno. U njega upišite:

Opera 1.5 1.9

6. Prvi  stupac  (nazivi  preglednika  weba)  i  prvi  redak 
(vremenske  oznake)  podebljajte,  a  boju  pozadine  tih 
ćelija promijenite na svijetlocrvenu.

7. Označite nešto deblji obrub vanjskih linija tablice.

8. Rubove  koji  odvajaju  podatke  u  tablici  (brojeve) 
označite crtkanom crtom.

9. Primijenite  samooblikovanje  tablice,  odaberite 
najprikladniji dizajn po vlastitoj želji.

10.Preuzmite  logo  preglednika  weba  Mozilla  Firefox  sa 
stranice:

http://www.mozilla.org/foundation/identity-guidelines/fir
efox-128.png

11.Unesite preuzeti logo u dokument, ispod tablice. 

12.Umnožite  logo  i  postavite  kopiju  u  redak  za  Mozilla 
Firefox.

13.Smanjite  logo  u  tablici  na  visinu  od  oko  dvije  visine 
retka.

14.Izradite  grafikon  koji  prikazuje  odnose  preglednika 
weba  kroz  mjesece.  Grafikon  je  oblika  linija,  na 
koordinati  X  nalaze  se  mjeseci,  a  na  koordinati  Y 
postotak korištenja različitih preglednika weba.

15.Spremite  dokument  pod  nazivom 
web_preglednici.odt.
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 6 Cirkularna pisma

 6.1 Ciljevi ovog poglavlja

Nakon ovog poglavlja moći ćete:
• razumjeti pojam cirkularnih pisama i njihovu primjenu,
• povezati dokument s izvorom podataka,
• pripremiti izvor podataka za spajanje,
• izraditi cirkularno pismo.

 6.2 Pojam cirkularnog pisma i izvora podataka 

Cirkularna  pisma  u  širem obliku  neizbježan  su  dio  rada  u 
programskom alatu za obradu teksta, za tvrtke, tijela državne 
uprave  i  druge  institucije  i  organizacije  koje  šalju  pisanu 
poštu na veći broj adresa. 

Problem je jednostavan: Kako poslati  isto (slično) pismo na 
velik  broj  adresa? Je  li  moguće svakom primatelju  napisati 
vlastiti pozdrav s njegovim imenom? Kako izraditi omotnice s 
adresama? Kako pisati naljepnice za lijepljenje na omotnice?

Sva ova pitanja su rješiva korištenjem mogućnosti za izradu 
cirkularnog  pisma  (Mail  Merge).  U  svim  ovim  slučajevima 
trebate imati neki izvor podataka, iz kojeg se mogu dohvaćati 
imena, prezimena, titule, adrese osoba. 

Takvi  su  izvori  podataka  najčešće  datoteke  tabličnih 
kalkulatora (Calc, Microsoft Excel) ili  lokalne baze podataka 
(Base,  Microsoft  Access),  no  mogu biti  i  drugi,  poput  baza 
podataka  dostupnih  putem  Interneta,  običnih  tekstualnih 
datoteka  i  slično.  Takve  se  datoteke  povezuju  s  pisanim 
dokumentom, a vrijednosti  određenih polja i stupaca unose 
se u dokument na mjestu određenom za to polje.

 6.3 Priprema glavnog dokumenta unosom polja

Prije  pripreme  samog  glavnog  dokumenta  unosom  polja, 
trebate  registrirati  –  povezati  –  dokument  s  izvorom 
podataka.  To  znači  da  dokument  s  podatcima  (baza 
podataka, proračunska tablica) već mora postojati. Također, 
potrebno je da su mu definirani nazivi kolona ili polja, kako 
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biste znali koji podatak trebate staviti na koje mjesto.

Ovdje  će  biti  prikazana  proračunska  tablica  programskog 
alata Calc (.ods) kao izvor podataka.
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Za registraciju izvora podataka trebate slijediti ove korake:

1. Otvorite  čarobnjak  putem  trake  izbornika,  Datoteka 
(File)  →  Čarobnjaci  (Wizards)  →  Izvornik podataka 
za adresar (Address Data Source);

2. Odaberite  tip  izvora,  u  ovom slučaju:  Drugi  vanjski 
izvor  podataka  (Other  external  data  source). 
Odaberite gumb Dalje >>.

3. Odaberite gumb Postavke (Settings).

4. Odaberite  tip  baze  podataka,  u  ovom  slučaju: 
Proračunska tablica  (Spreadsheet). Odaberite gumb 
Dalje >>.
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5. Pronađite lokaciju željene proračunske tablice.

6. Odaberite  gumb  Test  konekcije  (Test  Connection), 
kojim počinje kratak proces spajanja na izvor podataka. 
Ukoliko  je  pristup izvoru  podataka omogućen,  proces 
uspješno završava. Odaberite gumb Završi.

7. Slijedi  prozor  za  spajanje  standardnih  imena  polja  i 
imena iz  izvora podataka. S obzirom na način izrade 
koji će ovdje biti prikazan, ovaj korak nije potreban, pa 
trebate odabrati gumb Dalje >>.
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8. Na  završetku,  možete  još  jednom  provjeriti  lokaciju 
izvora podataka, te upisati naziv pod kojim će se ovaj 
izvor  moći  pronaći  u  dokumentu.  Završite  odabirom 
gumba Završi.

U  ovom  je  trenutku  završeno  spajanje  izvora  podataka  i 
dokumenta.  Sada  trebate  željena  polja  unijeti  u  tijelo 
dokumenta.  Točnije,  trebate  napisati  dokument  sa  svim 
zajedničkim dijelovima, znakovima i oblikovanjem, a onda na 
određena mjesta unijeti polja. 

Izvori podataka mogu se pregledati:

• putem trake izbornika, Pogled (View) → Izvori podataka 
(Data Sources),

• tipkom F4.

Novootvoreni prozor sadrži sve izvore podataka, s nazivima 
koji su zadani pri registraciji. Po izvorima se možete kretati 
dvostrukim  klikom  lijevom  tipkom  miša,  te  korištenjem 
znakova  plus  i  minus  (poput  upravljanja  mapama  u 
operacijskom sustavu). Dodavanje polja radi se ovako:

1. Unutar prozora Izvori podataka pronađite željeni izvor, 
popis tablica koje sadrži i željenu tablicu;

2. Dvaput  kliknite  lijevom  tipkom  miša  na  tablicu.  Na 
desnoj će se strani prikazati tablica s poljima;

3. Metodom  povlačenja  i  ispuštanja  (drag  &  drop) 
odvucite  naziv  polja  na mjesto u dokumentu gdje je 
potrebno prikazati taj podatak;
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4. U  dokumentu  će  se  dodano  polje  prikazati  sa  sivom 
nijansom pozadine;

5. Ponovite postupak potreban broj puta.

 6.4 Priprema datoteke s podacima

Ovdje će biti  prikazana proračunska tablica  Calc (.ods) kao 
izvor podataka.

Datoteku  trebate  pripremiti  iz  odgovarajućeg  programskog 
alata, npr.  Calc. Najjednostavnije, u prvom se retku trebaju 
nalaziti  nazivi  stupaca,  a  ispod  tablični  podaci.  Primjer 
adresara  bi  sadržavao  stupce  poput  Titula,  Ime,  Prezime, 
Ulica, Broj, PoštanskiBroj, Grad, Država...

 6.5 Spajanje popisa adresa

Konačno,  potrebno je  u "prazna" polja  postaviti  podatke iz 
izvora podataka. Za ovaj korak možete se poslužiti  dijelom 
čarobnjaka  za  izradu  cirkularnih  pisama,  Alati  (Tools)  → 
Čarobnjak Spajanja Pošte (Mail Merge Wizard).
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1. Na  lijevoj  strani  prozora  odaberite  8.  korak: 
Spremanje, ispis i slanje (Save, Print or Send);

2. Na desnoj  strani,  nakon spajanja,  pojavit  će se četiri 
opcije: 

1. Spremi  početni  dokument  –  spremanje 
dokumenta  s  poljima.  Vrlo  je  korisno  spremiti  ga 
kako biste kasnije jednostavno mogli napraviti novu 
inačicu dokumenta, bez ponovne definicije polja;

2. Spremanje  spojenih  dokumenata  –  dokumenti 
koji  nastaju  spajanjem  mogu  se  spremati,  bilo 
pojedinačno  (svako  pismo  posebno),  bilo  zajedno 
kao jedan dokument. Možete spremiti  sve ili  samo 
neke zapise;

3. Ispis  spojenih  dokumenata  –  ispis  na  pisač. 
Možete spremiti sve ili samo neke zapise;

4. Slanje spojenih dokumenata kao e-pošta – ova 
mogućnost  zahtijeva  postavljanje  paketa 
OpenOffice.org  kao  klijenta  elektroničke  pošte. 
Jednostavnije  je  spremiti  dokument  te  ga  poslati 
poštom  iz  omiljenog programa za rad s  e-poštom, 
poput Mozilla Thunderbirda ili Microsoft Outlooka.

3. Odaberite gumb Završi.
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 6.6 Česta pitanja

Kako  mogu  izrađivati  naljepnice  za  omotnice 
korištenjem izvora podataka?

Za  izradu  naljepnica/oznaka  koristite  dijaloški  prozor 
Datoteka  (File)  →  Novi  (New)  →  Oznake  (Labels).  Ovdje 
trebate definirati izvor podataka i izgled naljepnice u kartici 
Oznake,  te  izgled  naljepnice  što  uključuje  širinu,  visinu, 
razmak između naljepnica, broj naljepnica na jednom papiru i 
slično, u kartici Oblik (Format).

Mogu li kao izvor podataka navesti običnu, tekstualnu 
datoteku?

Da,  ako  datoteka  ima  određenu  strukturu  poput  polja 
odvojena  zarezom ili  nekim drugim znakom,  svaki  zapis  u 
jednom  retku  i  slično.  Pri  registraciji  za  izvor  podataka 
odaberite  Tekst,  a  ne  Proračunska  tablica, te  podesiti 
postavke vezane za strukturu datoteke.

 6.7 Zadaci za vježbu

1. U  programskom  alatu  Calc  izradite  dokument 
adresar.ods.  Pritom  može  pomoći  priručnik  Calc 
Tablične kalkulacije. Adresar u prvom retku sadrži polja 
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Ime,  Prezime,  Imenovanje,  Ulica,  Broj,  PoštanskiBroj, 
Grad.  U  sljedećim  retcima  upišite  podatke  nekoliko 
prijatelja ili poslovnih partnera.

2. Otvorite novi tekstualni dokument.

3. Povežite  izvor  podataka  adresar.ods s  tekstualnim 
dokumentom.

4. Napišite kratki dopis, koji na početku treba sadržavati 
mjesto  za  adresu  primatelja  i  osobni  pozdrav  (poput 
"Lijep pozdrav, Marija,").

5. Mjesto za adresu povežite s adresarom i popunite na 
ovaj način:

<Imenovanje> <Ime> <Prezime>

<Ulica> <Broj>

<PoštanskiBroj> <Grad>

6. Poslije  pozdrava  dodajte  polje  za  ime  (poput  "Lijep 
pozdrav, <Ime>,").

7. Napravite cirkularno pismo.

8. Spremite originalni dokument s poljima za podatke.

9. Spremite dobiveno cirkularno pismo (za sve osobe) u 
jednom dokumentu.

10.Ispišite prve 3 stranice cirkularnog pisma.
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 7 Priprema izlaznih rezultata

 7.1 Ciljevi ovog poglavlja

Nakon ovog poglavlja moći ćete:
• razumjeti potrebu pregleda dokumenta prije ispisa ili 

objavljivanja,
• korisititi ugrađenu provjeru pravopisa,
• dodati nepoznate riječi u rječnik,
• pregledati dokument prije ispisa,
• prilagoditi opcije ispisa, poput broja stranica i kopija,
• ispisati dokument na zadani pisač korištenjem zadanih 

opcija.

 7.2 Pripreme

 7.2.1 Važnost različitih provjera dokumenata

Smisao dokumenata je da budu čitani, pregledavani. Realna 
je  pretpostavka  da  će,  jednom  kada  dokument  bude  "u 
javnosti", različite osobe moći imati pristup dokumentu, bilo 
na  računalu,  bilo  ispisanoj  inačici.  Nakon  svih  oblikovanja, 
izrazito  je  važno  još  (barem!)  jednom provjeriti  dokument. 
Možda su se neke slike pomaknule s pretpostavljenih mjesta, 
neki  bi  odlomak  trebao  početi  na  novoj  stranici?  Je  li 
uključeno numeriranje  stranica?  Jesu  li  sve  vrste  i  veličine 
slova u redu? Jesu li margine dokumenta takve da će rubovi 
dokumenta  biti  čitljivi  nakon  ispisa?  Je  li  dokument  bez 
tiskarskih i gramatičkih pogrešaka? 

Zadnje je pitanje toliko važno da zaslužuje novo poglavlje. 

 7.2.2 Provjera i ispravak pravopisa

Nepoštivanje pravopisa i slučajne (tiskarske) pogreške odaju 
dojam  neprofesionalnosti  autora.  Stoga  je  dobro  provjeriti 
pravopis  dokumenta.  Do  provjere  pravopisa  možete  doći 
putem trake izbornika,  Alati  (Tools) →  Provjera pravopisa 
(Spellcheck).  Writer  prolazi kroz tekst dokumenta i pronalazi 
pravopisne pogreške. Ovdje je moguće promijeniti  jezik, po 
čijem će se rječniku provjeravati pravopis.
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Riječi kojih nema u rječniku pojavljuju se označene crvenom 
bojom.  Dolje  se  nalaze  prijedlozi  sličnih  riječi.  Gumb 
Promijeni  (Change)  služi  za  prihvaćanje  ponuđenih 
sugestija. Riječi za koje ste sigurni da su ispravno napisane 
možete ignorirati gumbima Zanemari jednom (Ignore Once) 
ili Zanemari sve (Ignore All) - sva pojavljivanja takvih riječi u 
ovom dokumentu. 

Nakon odluke o nepoznatoj riječi,  programski alat nastavlja 
provjeravati sljedeću riječ, do kraja teksta.  

 7.2.3 Dodavanje riječi u ugrađeni rječnik

Ugrađeni rječnik nije sveznajući. Moguće je da ne prepoznaje 
neke riječi koje su ispravne, no isto tako da postoji skup riječi 
koje često koristimo (kratice organizacija, programskih jezika, 
itd.),  koje  zasigurno  početno  nisu  u  rječniku.  Zato  postoji 
mogućnost  proširivanja  rječnika.  U  trenutku  prikaza 
neprepoznate riječi  u  prozoru  za provjeru  pravopisa,  gumb 
Dodaj dodaje neprepoznatu riječ u rječnik, te je programski 
alat više neće prijavljivati kao nepoznatu.

 7.2.4 Pregled dokumenta prije ispisa

Iako  Writer  u  usporedbi  s  ispisanom  inačicom  na  zaslonu 
prikazuje  prilično  "vjernu"  sliku  dokumenta,  ipak  je 
preporučljivo  prije  ispisa  pogledati  kako  će  dokument 
izgledati. Do takvog pogleda na dokument moguće je doći:

• putem  trake  izbornika,  Datoteka  (File)  →  Pregled 
stranice (Page Preview),
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• odabirom ikone  Pregled stranice (Page Preview) 

iz alatne trake.

Najvažnije mogućnosti pregleda ispisa su:

• jednostavno  povećavanje  i  smanjivanje  stranica 
ikonama Uvećaj (Zoom In) i Umanji (Zoom Out),

• odabir  broja  stranica  koje  želite  odjednom  prikazati 
(npr. dvije odjednom, četiri odjednom),

• brz pristup prozorima za ispis te postavke ispisa.

Iz ovog pogleda možete izaći:

• dvostrukim  klikom  lijevom  tipkom  miša  na  neku  od 
stranica,

• gumbom  Zatvori  pregled  (Close  Preview)  iz  alatne 
trake.

 7.3 Ispis

 7.3.1 Postavke ispisa

Postavke ispisa obuhvaćaju odabir stranice koje želite ispisati 
te  definiranje  različitih  elemenata  sadržaja,  koji  mogu  biti 
ispisani.  Do  postavki  se  dolazi  putem  trake  izbornika, 
Datoteka (File) → Ispis (Print).

Jednostavne  postavke  ispisa  nalaze  se  u  prvom, 
novootvorenom prozoru:

• Odabir pisača (Printer),
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• Raspon ispisa (Print range) – stranice koje je potrebno 
ispisati. Moguće je odabrati sljedeće opcije:

• Sve (All) – sve stranice u dokumentu,

• Stranice  (Pages) –  samo  određene  stranice. 
Stranice su odvojene zarezima, a crtica se koristi 
za raspon stranica (npr. 1, 3, 5-8, 10). Samo parne 
ili  samo  neparne  stranice  ispisuju  se  odabirom 
gumba Odrednice i odabirom Lijeve stranice ili 
Desne stranice. Postupak je objašnjen u daljnjem 
tekstu;

• Odabir  (Selection)  –  prethodno  odabran  dio 
dokumenta,

• Broj  kopija (Number  of  copies) –  broj  kopija 
dokumenta koje treba ispisati. Opcija  Svrstaj za 
uvez  (Collate)  definira  kojim  će  redoslijedom 
stranice biti ispisane.

Dodatne odrednice ispisa mogu se postaviti odabirom gumba 
Odrednice (Options). Ovdje možete postaviti:

• koje  je  elemente  sadržaja  potrebno  ispisati  (tablice, 
crteži...),

• koje  je  stilove  stranica  potrebno  ispisati  (Lijeva 
stranica, Desna stranica...),

• kako se ispisuju zabilješke u tekstu (na istom mjestu, 
na kraju stranice, na kraju dokumenta,

• treba li slike prilagoditi crno-bijelom ispisu.
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 7.3.2 Ispis dokumenta

Nakon  uređivanja  svih  postavki,  dokument  možete  ispisati 
gumbom  U redu  iz  gornjeg prozora za uređivanje postavki 
ispisa.

Također, možete izravno ispisati dokument,  odabirom ikone 

Izravni  ispis  datoteke  (Print  File  Directly) iz  alatne 
trake Standardno. U ovom slučaju prozor za postavke neće 
biti prikazan.

 7.4 Česta pitanja

Kako mogu ispisati samo trenutnu stranicu? 

Trenutnu  stranicu  možete  ispisati  odabirom  radio  gumba 
Stranice u dijaloškom prozoru za ispis. Primijetite kako je broj 
trenutne stranice već napisan. Ovaj način je odabran kako bi 
se spriječio ispis "krive" trenutne stranice. Trenutna stranica 
je ona na kojoj se nalazi pokazivač, a ne ona koja se trenutno 
nalazi na zaslonu računala.

Kako mogu promijeniti orijentaciju dokumenta?
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Jeste li znali...

Odaberete li ikonu Izravni ispis datoteke (Print file directly) 
iz alatne trake, ispis započinje odmah bez otvaranja prozora 
za prilagodbu postavki. U mrežnom okruženju važno je 
prilagoditi i provjeriti postavke prije svakog ispisa kako 
prezentacija ne bi bila ispisana na pisaču na drugom katu, 
odjelu ili čak u drugoj zgradi.



Orijentacija dokumenta povezana je, logično, sa stranicama 
dokumenta, a ne s ispisom. Zato se ta mogućnost nalazi u 
dijaloškom prozoru  Oblik  (Format)  →  Stranica  (Page),  na 
kartici Stranica.
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 7.5 Zadaci za vježbu

1. Otvorite dokument web_preglednici.odt.

2. Provjerite pravopis dokumenta. Ako ne postoje, dodajte 
riječi  Mozilla,  Firefox,  Internet,  te  Explorer  u  rječnik. 
Zašto nije potrebno dodati riječ Opera?

3. Umnožite  cijeli  sadržaj  dokumenta  još  jednom,  u  isti 
dokument.

4. Provjerite kao dokument izgleda u pregledu prije ispisa. 
Koristite pregled dvije stranice odjednom.

5. Ispišite  samo  drugu  stranicu.  Prilikom  ispisa  obratite 
pažnju na koji će se pisač ispisati dokument.

6. Ispišite cijeli dokument, no nemojte ispisati tablice. 
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 8 Međudjelovanje programskih alata 
OpenOffice.org 

Svaki  programski  alat  u  paketu  OpenOffice.org  ima  skup 
zadaća  koje  najbolje  obavlja.  No,  to  ne  znači  da  i  drugi 
programski alati ne mogu obavljati dio tih zadaća, obično u 
manjem opsegu. Jedan od primjera su proračunske tablice, za 
koje je predviđen programski alat Calc, no dio mogućnosti za 
tablične proračune sadrži i programski alat  Writer. Za nešto 
složenije  zadatke,  postoji  mogućnost  međusobne  suradnje 
između programskih alata, na način umetanja dijela podataka 
iz drugog programskog alata. Na primjer, unutar tekstualnog 
dokumenta  kojeg  se  oblikuje  u  Writeru  može  se  dodati 
proračunska  tablica,  s  mogućnostima  vrlo  sličnim  tablici  u 
programskom alatu  Calc. Dodatno, moguće je unutar nekog 
dokumenta unijeti i  već postojeći dokument različitog tipa i 
izravno raditi na njemu.

Evo kako postići međusobnu "suradnju" programskih alata, s 
osnovnim  dokumentom  -  tekstualnim  dokumentom 
formata .odt.

 8.1 Umetanje .ods tablice

Tablicu  za  uređivanje  u  programskom  alatu  Calc  možete 
unijeti  u  Writer kao OLE objekt  (vidjeti  poglavlje  Umetanje 
OLE objekata).  Taj  način služi  za umetanje različitih  tipova 
podataka, a ne samo .ods tablice.

Na  sredini  dokumenata  pojavljuje  se  prazna  proračunska 
tablica. Za uređivanje tablice, kao i svakog objekta kojeg ćete 
uređivati na ovaj način, potrebnu ju je prethodno aktivirati. 
Aktivacija se vrši dvostrukim odabirom lijevom tipkom miša 
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na objekt.  Aktivacijom će  trake alata  i  traka  izbornika  biti 
promijenjene i sličnije programskom alatu Calc. Pri dodavanju 
objekta,  aktivacija  će  automatski  biti  izvršena,  pa  nije 
potrebno aktivirati novododani objekt.

Unošenje  podataka  istovjetno  je  unošenju  podataka  u 
programski  alat  Calc.  Moguće  je  služiti  se  i  mišem  i 
tipkovnicom. Više o programskom alatu Calc možete saznati 
u drugom priručniku, "Calc - tablične kalkulacije".

Drugi način dodavanja je uobičajeno umnažanje/premještanje 
korištenjem  međuspremnika.  Za  dodavanje  dijela  ili  cijele 
.ods tablice slijedite ove korake:

1. U programskom alatu  Calc  otvorite  ili  izradite željenu 
tablicu;

2. Označite polja koja želite dodati u dokument;

3. Premjestite  polja  u međuspremnik  nekom od metoda 
(Izreži (Cut), Ctrl+X, Kopiraj (Copy), Ctrl+C);

4. U  dokumentu  umetnite  /  zalijepite  trenutni  sadržaj 
međuspremnika  nekom od  metoda  (Umetni  (Paste), 
Ctrl+V).

Na ovaj način rezultat je jednak prvom načinu, tj. dodavanju 
nove  proračunske  tablice,  s  tom  razlikom  što  ovdje  već 
postoje podaci uneseni u programskom alatu Calc.

Važno je napomenuti:  Ova dva izvora podataka više nisu 
povezana.  Mijenjanje  podataka  na  jednom  mjestu  neće 
utjecati na podatke na drugom!

 8.2 Umetanje grafikona

Često se, osim proračuna, u programskom alatu Calc izrađuju 
i  grafikoni.  Podaci  koji  se  nalaze  u  tablici  obično  su  izvor 
podataka za grafikone, pa je ta mogućnost korisna. Grafikoni 
izrađeni  u  programskom  alatu  Calc  mogu  se  jednostavno 
prenijeti  u  dokument.  Načini  prenošenja  jednaki  su  gore 
opisanom prenošenju tablice. 

Grafikon  prenesen  u  dokument  zadržava  sva  svojstva 
grafikona, kao da je izrađen putem programskog alata Writer. 
No, podaci za izradu grafikona su preneseni, što znači da ih 
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nije potrebno ponovno unositi.

Važno je napomenuti:  Ova dva izvora podataka više nisu 
povezana.  Mijenjanje  podataka  na  jednom  mjestu  neće 
utjecati na podatke na drugom!

 8.3 Umetanje OLE objekata

OLE (Object Linking and Embedding) objekti  su namijenjeni 
prijenosu između različitih programskih alata. Obično se radi 
o nekoj vrsti dokumenta, koji  se može obrađivati u jednom 
programskom alatu. Umetanjem i aktiviranjem OLE objekta, 
moguće  je  izravno  uređivati  sadržaj  objekta  iz  novog 
programskog alata. Ovaj je proces jednostavan za korisnika 
ako se radi o objektima istog programskog paketa. Ako to nije 
slučaj, programski alat u čiji je dokument unesen OLE objekt 
će u novom prozoru otvoriti programski alat kojim se sadržaj 
objekta može urediti.

Primjeri umetanja iz prethodnih poglavlja su OLE objekti, no 
zbog učestalosti korištenja su izdvojeni u posebna poglavlja. 
Sve vrste dokumenata paketa OpenOffice.org mogu se unijeti 
u Writer kao OLE objekti. Za unos slijedite ove korake:

1. Odaberite naredbu Ubaci (Insert) → Objekt (Object) → 
OLE objekt (OLE Object);

2. Želite li izraditi novi objekt:
1. Odaberite Napravi novi (Create new);
2. Odaberite vrstu objekta kojeg želite dodati 

(proračunsku tablicu, oblikovani tekst, crtež...);

3. Želite li izraditi objekt iz već postojeće datoteke:
1. Odaberite Napravi iz datoteke (Create from file);
2. Pronađite datoteku u datotečnom sustavu.
3. Označite Poveži s datotekom (Link to file), ako želite 

da promjene sadržaja doista budu spremljene u 
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Dodavanje 
novog OLE 
objekta



izvornu datoteku. Ako želite samo preuzeti podatke i 
mijenjati ih bez spremanja u izvornu datoteku, 
nemojte označiti ovu mogućnost.

Kao i u prethodno navedenim slučajevima, i ovdje je potrebno 
aktivirati  objekt prije uređivanja,  dvostrukim klikom lijevom 

tipkom miša.
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Jeste li znali...

Kao OLE objekte moguće je unijeti ne samo datoteke 
paketa OpenOffice.org, već i mnoge druge tipove 
datoteka. Želite li unijeti takve objekte, u prozoru za 
unos odaberite tip objekta: Drugi objekti (Further 
objects). Na ovaj je način moguće unijeti dokumente 
paketa Microsoft Office.

Slika 110: 
Izrada novog 
OLE objekta iz 
postojeće 
datoteke
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Dozvola uporabe ovog djela (cjelovit tekst)

Imenovanje-Nekomercijalno-Dijeli pod istim uvjetima 2.5 

PRAVNI  SUBJEKT  CREATIVE  COMMONS  NIJE  PRAVNA  TVRTKA  I  NE 
PRUŽA  PRAVNE  USLUGE.  DISTRIBUIRANJE  OVE  LICENCE  NE 
USPOSTAVLJA ODNOS PRAVNOG ZASTUPANJA. CREATIVE COMMONS 
NUDI  OVU  LICENCNU  INFORMACIJU  "KAKVA  JEST".  CREATIVE 
COMMONS  NE  JAMČI  ZA  PRUŽENE  LICENCNE  INFORMACIJE  I  NE 
ODGOVARA  ZA  ŠTETU  KOJA  BI  MOGLA  PROIZAĆI  IZ  NJIHOVOG 
KORIŠTENJA.

Licenca 

DJELO  (KAKO  JE  NIŽE  DEFINIRANO)  PONUĐENO  JE  POD  UVJETIMA  OVE 
CREATIVE  COMMONS  JAVNE  LICENCE  (“CCJL”  ILI  “LICENCA”).  DJELO  JE 
ZAŠTIĆENO  AUTORSKIM  PRAVOM  I  SRODNIM  PRAVIMA  TE  DRUGIM 
POZITIVNIM  PROPISIMA.  SVAKO  KORIŠTENJE  DJELA  KOJE  ODSTUPA  OD 
DOPUŠTENOGA POD OVOM LICENCOM JE ZABRANJENO. 

KORIŠTENJEM  BILO  KOJIH  OVDJE  PONUĐENIH  PRAVA  NA  DJELO 
PRIHVAĆATE I  PRISTAJETE DA STE OBAVEZANI  UVJETIMA OVE LICENCE. 
DAVATELJ  LICENCE  DAJE  VAM  OVDJE  SADRŽANA  PRAVA  POLAZEĆI  OD 
TOGA DA PRIHVAĆATE TAKVE UVJETE I ODREDBE. 

1. Definicije 

a. “Davatelj  licence” znači  fizička  osoba  koja  nudi  korištenje  Djela  pod 
uvjetima ove Licence. 

b. “Djelo” znači originalna intelektualna tvorevina individualnog karaktera koja 
je ponuđena pod uvjetima ove Licence. 

c. "Elementi licence" znači najviše atribute licence koju je izabrao Davatelj 
licence  kako  stoje  u  naslovu  ove  Licence:  Imenovanje,  Nekomercijalno, 
Dijeli pod istim uvjetima. 

d. “Izvorni autor” znači fizička osoba koja je stvorila Djelo. 

e. “Prerada” znači  prijevod,  prilagodba,  glazbena  obrada  i  druga  prerada 
autorskog  djela,  koja  je  originalna  intelektualna  tvorevina  individualnog 
karaktera. 

f. “Vi” znači fizička ili pravna osoba koja koristi prava u skladu sa sadržajem 
ove licence i nije prethodno prekršila uvjete ove Licence s obzirom na Djelo 
ili netko tko je primio izričito dopuštenje od davatelja Licence da koristi prava 
dana pod ovom Licencom unatoč prethodnom kršenju. 

g. “Zbirka” označava zbirku samostalnih autorskih djela, podataka ili  druge 
građe kao što su enciklopedije, zbornici, antologije, baze podataka i sl., koje 
prema izboru ili  rasporedu sastavnih elemenata čine vlastite intelektualne 
tvorevine njihovih autora. Tu se ubrajaju i one zbirke koje su uređene po 
određenom sustavu ili metodi, čiji su elementi pojedinačno dostupni putem 
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elektroničkih  ili  drugih  sredstava.  Za  svrhe  ove  Licence  djelo  koje  tvori 
Zbirku neće se smatrati Preradom (onako kako je gore definirano). 

2. Ograničenja autorskog prava. Ova licenca ničime ne umanjuje, ograničava ili 
onemogućava prava koja proizlaze iz sadržajnih ograničenja autorskog prava prema 
Zakonu o autorskom pravu i srodnim pravima te drugim pozitivnim propisima. 

3. Licenciranje. Prema uvjetima i odredbama ove Licence, Davatelj  licence Vam 
ovime  dodijeljuje  pravo,  koje  je  oslobođeno  naknade,  neisključivo,  prostorno  i 
vremenski  (za  trajanja  mjerodavnog  autorskog  prava)  neograničeno,  da  koristite 
Djelo kako je niže navedeno: 

a. da reproducirate  Djelo,  da uključujete  Djelo u jedno ili  više Zbirki,  te  da 
reproducirate Djelo kako je uključeno u Zbirke; 

b. da stvarate i reproducirate Prerade; 

c. da  distribuirate  kopije  ili  fonograme  Djela  i  priopćavate  Djelo  javnosti, 
uključujući i Djelo kako je uključeno u Zbirke; 

d. da distribuirate kopije ili fonograme Prerada i da ih priopćavate javnosti. 

Gore  navedena  prava  mogu  se  koristiti  u  svim  poznatim  i  budućim  medijima  i  
formatima. Gore navedena prava uključuju pravo da se načine one izmjene koje su 
tehnički nužne da bi se koristilo prava u drugim medijima i formatima. Sva prava koja  
Davatelj licence nije izričito dao ovime su pridržana.

4. Ograničenja. Prava dana Člankom 3. izričito podliježu sljedećim ograničenjima: 

a. Djelo  smijete  distribuirati  i  priopćavati  javnosti  samo  pod  uvjetima  ove 
Licence, a kopiju te Licence ili  njenu internetsku adresu morate uključiti  u 
svaku kopiju ili fonogram Djela koji distribuirate ili priopćavate javnosti. Ne 
smijete  ponuditi  ili  nametnuti  bilo  kakve  uvjete  za  Djelo  koji  mijenjaju  ili 
ograničavaju  uvjete  ove Licence  ili  primateljevo korištenje  prava koja  su 
njome osnovana. Ne smijete podlicencirati Djelo. Morate ostaviti netaknuta 
sva upozorenja koja se odnose na ovu Licencu i upozorenje o jamstvima. 
Ne  smijete  distribuirati  ili  priopćavati  javnosti  Djelo  pomoću  tehnoloških 
mjera  koje  kontroliraju  pristup  ili  upotrebu  Djela  na  način  koji  nije 
konzistentan s uvjetima ovog Licencnog ugovora. Sve se ovo odnosi i na 
Djelo kada je uključeno u Zbirku,  ali  to ne iziskuje da osim samog Djela 
cjelokupna Zbirka podliježe uvjetima ove Licence. Ako stvarate Zbirku, po 
upozorenju bilo kojeg Davatelja licence morate, na način kako je zatraženo, 
a u mjeri u kojoj je izvedivo, iz Zbirke ukloniti bilo koju oznaku i priznanje 
autorstva  kakvo  je  propisano  u  stavku  4(d).  Ako  stvarate  Preradu,  po 
upozorenju bilo kojeg Davatelja licence morate, na način kako je zatraženo, 
a u mjeri u kojoj je izvedivo, iz Prerade ukloniti bilo koju oznaku i priznanje 
autorstva kakvo je propisano u stavku 4(d). 

b. Preradu smijete distribuirati ili  priopćavati javnosti samo pod uvjetima ove 
Licence,  pod  uvjetima  kasnije  verzije  ove  Licence  s  istim  Elementima 
licence  kao  što  ih  ima  ova  Licenca  ili  pod  uvjetima  Creative  Commons 
iCommons licence koja sadrži iste Elemente licence kao ova Licenca (npr. 
Imenovanje-Nekomercijalno-Dijeli  pod  istim  uvjetima  2.5  Japan).  Morate 
uključiti  kopiju  ili  internetsku  adresu  ove  Licence  ili  neke  druge  licence 
navedene u prethodnoj rečenici u svaku kopiju ili fonogram svake Prerade 
koju distribuirate ili priopćavate javnosti. Ne smijete ponuditi ili nametnuti bilo 
kakve uvjete za Prerade koji mijenjaju ili ograničavaju uvjete ove Licence ili 
primateljevo korištenje njome danih prava te morate ostaviti netaknuta sva 
upozorenja koja se odnose na ovu Licencu i upozorenje o jamstvima. Ne 
smijete  distribuirati  ili  priopćavati  javnosti  Preradu  pomoću  bilo  kakve 
tehnološke mjere koja kontrolira pristup ili upotrebu Djela na način koji nije 
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konzistentan s uvjetima ovog Licencnog ugovora. Sve ovo se odnosi i na 
Preradu kada je uključena u Zbirku, ali to ne iziskuje da osim same Prerade 
cjelokupna Zbirka podliježe uvjetima ove Licence. 

c. Ne smijete iskoristiti niti jedno pravo koje Vam je dano u Članku 3. na način 
koji  ima  za  primarni  cilj  ili  je  usmjeren  na  komercijalno  iskorištavanje  ili 
privatnu  novčanu  naknadu.  Razmjena  Djela  za  druga  autorskim  pravom 
zaštićena djela putem digitalne razmjene datoteka ili na kakav drugi način 
neće se smatrati da ima za primarni cilj ili da je usmjerena na komercijalno 
iskorištavanje ili privatnu novčanu naknadu, pod uvjetom da nema plaćanja 
bilo  kakve  novčane  naknade  vezane  uz  razmjenu  autorskim  pravom 
zaštićenih djela. 

d. Ako distribuirate ili priopćavate javnosti Djelo ili bilo kakve Prerade ili Zbirke, 
morate ostaviti netaknutima sva upozorenja o autorskom pravu za Djelo i, u 
mjeri u kojoj je primjereno za medije ili sredstva koja koristite, istaknuti: (I) 
ime Izvornog autora (odnosno,  ako je to  slučaj,  pseudonim),  ako je ime 
navedeno, i/ili (II) ako Izvorni autor i/ili Davatelj licence u svojoj obavijesti o 
autorskim pravima, uvjetima usluge ili drugim primjerenim sredstvima odredi 
da  se  imenuje  neka  druga  stranka  ili  stranke  (npr.  institucija  pokrovitelj, 
izdavač, časopis),  ime te stranke ili  stranaka; naslov djela, ako je naslov 
naveden; internetsku adresu vezanu uz Djelo - u mjeri u kojoj je to razumno 
izvedivo i ako postoji, onako kako ju je specificirao autor, osim u slučaju da 
se ta internetska adresa ne odnosi na upozorenje o autorskom pravu ili na 
licencnu informaciju za Djelo; a u slučaju Prerade, naznaku koja upućuje na 
Djelo korišteno u Preradi (npr. “Francuski prijevod Djela Izvornog autora” ili  
“Scenarij prema izvornom Djelu Izvornog autora”). Takva naznaka može se 
navesti  na bilo koji  način koji je primjeren; međutim, u slučaju Prerade ili 
Zbirke uz minimalni uvjet da će se takvo priznanje pojaviti na mjestu gdje se 
javljaju druga istovrsna priznanja autorstva i na barem podjednako istaknut 
način kao druga istovrsna priznanja autorstva. 

5. Jamstva 

OSIM  AKO  STRANKE  NISU  DRUGAČIJE  NAPISMENO  UGOVORILE  ILI  JE 
ODREĐENO  MJERODAVNIM  PRAVOM,  DAVATELJ  LICENCE  NUDI  DJELO 
"KAKVO JEST", BEZ JAMSTAVA BILO KOJE VRSTE VEZANIH UZ DJELO.

6.  Ograničenje  odgovornosti.  OSIM  JAMSTAVA  IZ  ČLANKA  5.,  DAVATELJ 
LICENCE  ĆE  SNOSITI  ODGOVORNOST  SAMO  ZA  ŠTETE  UZROKOVANE 
NAMJERNO ILI IZ KRAJNJE NEPAŽNJE. 

7. Prestanak važenja 

a. Licenca i prava korištenja koja su njome dana prestat će automatski važiti 
prekršite li uvjete Licence. Za fizičke i pravne osobe koje su od Vas primile 
Preradu ili Zbirku pod ovom Licencom Licenca nastavlja važiti, pod uvjetom 
da se te fizičke ili pravne osobe u potpunosti pridržavaju Licence. Članci 1., 
2.,  5.,  6.,  7. i  8. nastavljaju važiti  i  nakon svakog prestanka važenja ove 
Licence. 

b. Unutar gore navedenih uvjeta i  odredbi  ovdje dana Licenca je trajna (za 
trajanja  mjerodavnog  autorskog  prava  na  Djelo).  Unatoč  tome,  Davatelj 
licence pridržava pravo da izdaje Djelo pod drugačijim licencnim uvjetima ili 
da  u  bilo  koje  doba prestane distribuirati  Djelo -  pod uvjetom da takvim 
izborom ne prestaje važiti ova Licenca (niti druge licence koje su izdane, ili  
su morale biti izdane, na temelju nje) te da će ova Licenca nastaviti važiti 
punom snagom ako nije prestala važiti prema prethodnom stavku. 
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8. Završne odredbe 

a. Svaki put kada umnažate, distribuirate ili priopćavate javnosti Djelo ili Zbirku, 
Davatelj  licence  primatelju  nudi  licencu  na  djelo  pod  istim  uvjetima  i 
odredbama kako je Vama dano pod ovom Licencom. 

b. Svaki  put  kada  umnažate,  distribuirate  ili  priopćavate  javnosti  Preradu, 
Davatelj licence primatelju nudi licencu na izvorno Djelo pod istim uvjetima i 
odredbama kako je Vama dano pod ovom Licencom. 

c. Ako  je  bilo  koja  odredba  ove  Licence  nevažeća  i  neprovediva  po 
mjerodavnom  pravu,  to  neće  utjecati  na  provedivost  ostalih  uvjeta  ove 
Licence, i to bez daljnjeg djelovanja stranaka ovog ugovora, a takva će se 
odredba  preoblikovati  u  najmanjoj  mogućoj  mjeri  potrebnoj  da  postane 
važeća i provediva. 

d. Neće se smatrati  da je bilo dopušteno odstupanje od bilo kojeg uvjeta ili  
odredbe ove Licence ili da je dan pristanak na bilo kakvo kršenje, ako takvo 
dopuštenje ili  takav pristanak nisu dani u pismenom obliku i  potpisani od 
stranke koja daje takvo dopuštenje ili pristanak. 

e. Licenca  čini  cjelokupni  ugovor  između  stranaka  u  pogledu  Djela  koje  je 
ovdje licencirano. Nema nikakvih daljnjih sporazuma ili usmenih dogovora u 
pogledu  Djela  koja  nisu  ovdje  specificirana.  Davatelja  licence  neće 
obvezivati nikakve dodatne odredbe koje bi se mogle pojaviti u bilo kakvom 
usmenom  dogovoru  s  Vama.  Ova  licenca  ne  može  se  mijenjati  bez 
zajedničkog ugovora u pisanom obliku između Davatelja licence i Vas. 

Creative  Commons  nije  stranka  u  ovoj  Licenci  i  ne  pruža  nikakvo  jamstvo 
vezano uz Djelo.  Creative Commons neće prema Vama ili  bilo  kojoj  stranci 
snositi odgovornost prema bilo kojoj pravnoj teoriji za bilo kakve štete. Unatoč 
prethodne dvije (2) rečenice, ako se Creative Commons izričito očitovao kao 
Davatelj licence pod ovom Licencom, on će imati sva prava i obaveze Davatelja 
licence. 

Osim u ograničenu svrhu ukazivanja javnosti da je Djelo licencirano pod CCJL, 
nijedna stranka neće koristiti zaštitni znak “Creative Commons” bez prethodnog 
pismenog pristanka od strane Creative Commons. Svaka dopuštena upotreba 
pridržavat će se u tom trenutku važećih smjernica za korištenje zaštitnog znaka 
- onako kako su objavljene na Creative Commons web stranici ili na neki drugi 
način, na zahtjev, povremeno stavljene na raspolaganje.

Kontakt s Creative Commons moguće je uspostaviti na http://creativecommons.org/.

Tekst licencije preuzet u cijelosti sa: 
http://creativecommons.org/licenses/by-nc-sa/2.5/hr/legalcode
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